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Introduction Welcome

Welcome

The SerailXpress software is designed to work with the following Tektronix arbitrary waveform generators:

AWG70000A Series arbitrary waveform generator (firmware V3.0 and above).

AWG7000C series arbitrary waveform generators.

AWG7000 and AWG7000B series arbitrary waveform generators have not been fully tested with
SerialXpress version 4.0 and above. SerialXpress version 3.3 is recommended for these products.

AWG5000C series arbitrary waveform generators.

AWG5000 and AWG5000B series arbitrary waveform generators have not been fully tested with
SerialXpress version 4.0 and above. SerialXpress version 3.3 is recommended for these products.

This software can be run in several ways.

SerialXpress Installed on a PC and connected to an AWG70000A Series arbitrary waveform generator
via a LAN connection.

See the section AWG70000A Series configuration utility (see page 4.) to prepare SerialXpress for
use with an AWG70000A Series arbitrary waveform generator.

An integral part of an AWG5000C or AWG7000C series arbitrary waveform generators (SerialXpress
installed on the AWG).

As a standalone product installed on a PC.

Free Trial

SerialXpress supports Option SSC that enables SSC parameters and Option ISI that enables ISI options.
You can transfer or save the data for ten trials. When the trial expires, you cannot transfer or save the
waveform unless you enable the function with an option (license) key.

For more details, refer to Option Installation (see page 31).
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Related Documentation

In addition to this SerialXpress Online Help, the following documentation is included with the software:

SerialXpress Installation Manual (Tektronix part number 077-0049-xx). The installation manual has
information about installing and upgrading the software.

SerialXpress User Manual (Tektronix part number 077-0050-xx). The user manual is adapted from
the online help and is available in PDF format.

SerialXpress Quick Start User Manual (Tektronix part number 077-0064-xx). The quick start user
manual has information about using the software and application examples.

SerialXpress Programmer Online help (Tektronix part number 076-0166-xx). The programmer online
help has information on how to use commands for remotely controlling your instrument.

SerialXpress Programmer Manual (Tektronix part number 077-0144-xx). The programmer manual is
adapted from the programmer online help and is available in PDF format.

Conventions

The online help uses the following conventions:

When steps require a sequence of selections using the software interface, the ">" delimiter marks each
transition between a menu and an option. For example, File > Save.

DUT refers to the Device Under Test.

The terms "waveform" and "signal" are used interchangeably.

The term AWG refers to a Tektronix Arbitrary Waveform Generator.

Feedback

Tektronix, Inc.

14200 SW Karl Braun Drive

P.O. Box 500

Beaverton, OR 97077

USA

For product information, sales, service, and technical support:

In North America, call 1-800-833-9200.

Worldwide, visit www.tektronix.com to find contacts in your area.
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Minimum System Requirements

The minimum requirements of the SerialXpress application are listed in the following table:

Table 1: Minimum system requirements

Supported OS Windows 7 Professional

Minimum Requirements 2.0 GHz or higher

1 GB RAM

2 GB free disk space

1024 x 768 display resolution with 120 dpi font size

xxx

Prerequisites

TekVisa version 4.0.0.80 or above to communicate with the AWG70000A Series signal generators (or
other test instruments), over a LAN. If TekVisa is not already installed in your system, you can install it
from the SerailXpress application DVD or download the software from www.tektronix.com/software

Ordering SerialXpress

SerialXpress can be ordered as follows:

Table 2: Ordering SerialXpress

Software packages and options Description

SDX100 Jitter generation software package for AWG (includes
option key).

Option ISI S-Parameter and ISI creation option (requires SDX100 as
prerequisite).

Option SSC Spread Spectrum Clock addition option (requires SDX100
as prerequisite).

SDXUP Base Software upgrade for SDX100.

Option ISI Upgrade to include S-Parameter and ISI creation option
for SDX100.

Option SSC Upgrade to include Spread Spectrum Clock option for
SDX100.

xxx
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Installation

An installation wizard installs SerialXpress. If you have not installed MATLAB Runtime version and
.NET 4.0, the installer will detect and install it. You can install SerialXpress from the application CD
Browser. You can also install TekVISA from the CD Browser. You can cancel the installation any time
during the process.

NOTE. You can download the TekVISA software from www.tektronix.com/software. You can also install
TekVISA from the path \TekVISA on the application CD.

For details on how to install the application, refer to the SerialXpress Installation Manual (Tektronix part
number 077-0049-XX) available as a PDF on the CD-ROM.

You can uninstall in either of these two ways:

From Start > All Programs > Tektronix SerialXpress > Uninstall SerialXpress.

From Add/Remove programs in Control panel.

AWG70000 Series configuration utility

To use SerialXpress with an AWG70000 Series arbitrary waveform generator, you must run the
AWG70000 Configuration Utility. This should be done before starting SerialXpress. The utility only needs
to be run once to provide SerialXpress with the AWG70000 Series model and its options. SerialXpress
stores these setting for all subsequent starts of SerialXpress.

The configuration utility is located in the Tektronix SerialXpress Program folder.

When the configuration utility starts, simply enter your AWG70000 Series model number and its options.
This information provides SerialXpress with the information to properly adjust variables (such as sampling
rate and waveform length) to accommodate the features of the AWG70000 Series generators.

NOTE. All instrument information entered here must match your AWG70000 Series instrument exactly,
including all options. Any mismatch of information will cause an error when attempting to connect
to the instrument.
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Setup for Base Data Signal Generation (AWG70000A)

1. Start SerialXpress installed on the PC.

2. From the toolbar, select the signal type.

3. Make connections as shown in the figure:

Connect the AWG Ch 1 Analog Output to the DUT where the signal must be fed.

4. Click Compile. The waveform is compiled according to the default settings in the Compile Settings
window. The compiled waveform is displayed in the Waveform List. If the Compile Button
Preferences is set to Compile and Send, this waveform is transferred to the AWG channel (Ch1) and is
also seen in the Instrument Control > AWG tab.
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Getting Started Setup for Base Data Signal Generation (AWG5000 and AWG7000)

NOTE. The default setting for the Compile Button Preferences is to compile only. If you want to compile
and automatically send the waveform to the AWG, you need to change the Compile Button Preferences.
See Compile Settings (see page 25).

5. Use the AWG70000A controls to turn the channel on or off and run (output) the signal.

For more details, refer to Calibration for Base Pattern Signals (see page 51) and Find Instruments (see
page 23).

Setup for Base Data Signal Generation (AWG5000 and AWG7000)

1. Start the SerialXpress installed on the Arbitrary Waveform Generator (AWG).

2. Select the Standard and Pattern type from the Base Pattern tab.

3. Connect the AWG Ch1 Analog Output to the DUT where the base data waveform must be fed.

4. Click Compile in the toolbar. The waveform is compiled according to the default settings in the
Compile Settings dialog box. The compiled waveform is displayed in the Waveform List. This
waveform will be transferred to the AWG channel (Ch1) and can also be seen in the Instrument
Control > AWG tab.

5. Click On/Off to turn on Ch1.

6. Click Run to generate the waveform on the AWG.

For more details, refer to Calibration for Base Pattern Signals (see page 51) and Find Instruments (see
page 23).
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About Basic Operations

The basic operations section describes the application, tells how to start the application, use the menus and
toolbars, and describes the dialog boxes.

In this online help, all menu selections are indicated with Menu name and Menu options separated by
“>”. You can access a command or a menu option in more than one way. Several main menu options are
available in a toolbar that you can use instead of selecting the option from the main menu. Shortcut menus,
which open with a right-click, are provided for renaming, deleting waveforms, showing graphs, saving
data, importing data from a Tektronix oscilloscope, and transferring a waveform to an AWG.

Some dialog boxes also have a Help button that displays help for that dialog box.

Detailed operations and parameters are described in the sections on Base Pattern, Transmitter, and
Channel/Cable. The Reference section lists Error Messages, Shortcut Keys, Default states/values, Table
of Measurements, and additional information on Calibration, Interleave, Noise, Pseudo Random Binary
Sequence (PRBS), Spread Spectrum Clocking (SSC), Wrap between sequence elements, Inter Symbol
Interference (ISI), and so on.

The following figure shows the SerialXpress screen, the menu, the toolbar, and other elements of the
display.
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Operating Basics Overview of the Software

Overview of the Software

SerialXpress is a tool for the high speed serial data industry that takes an input pattern and creates
pre-distorted waveforms to test a device's conformance to SATA, SAS, Display Port, Fiber Channel,
USB, MIPI, and PCI-Express standards.

Key Features

Jitter Generation: Up to four different sinusoidal jitters with different amplitudes, frequencies and
phases can be added to a base pattern. Three independent band-limited random jitters can also
be added to the base pattern.

SSC Addition: SSC can be added with precisely controlled profile, spread, deviation, modulation,
and df/dt.

Advanced Pre/De-emphasis and Noise: Many standards such as PCI-E require the output waveform to
be pre/de-emphasized. SerialXpress allows easy addition of pre/de-emphasis including preshoot with
all other jitter parameters. Vertical noise can be added at both near and far ends of the channel. This
can also be set to either full band Gaussian noise or to a sinusoidal noise at a particular frequency.

Inter Symbol Interference (ISI) Creation: SerialXpress allows you to create ISI either by entering it
directly or from an S-parameter file captured either from a Tektronix sampling oscilloscope or a Vector
Network Analyzer. The S-parameter can be directly convolved with the base pattern to recreate the
channel characteristics. By applying an inverse filter, the effects of the channel can be de-embedded
from the circuit. The ISI within the S-parameter can be scaled upward or downward easily altering the
characteristics of the channel.

Base Pattern: SerialXpress is bundled with several sample patterns for various standards like SATA,
Display Port, SAS, PCI-E, Fiber Channel, MIPI, and USB. Patterns can also be directly entered in a
Binary, Hex, or Symbol editor, or loaded from a file.

Idle State: Standards like SATA call for OOB signaling which requires an idle state followed by a
burst. You can directly create this idle state without using additional power dividers. Noise can also be
added to these idle state waveforms.

Calibration: SerialXpress has a built-in calibration routine, which controls a Tektronix oscilloscope
and calibrates the output of a Tektronix arbitrary waveform generator (AWG) for periodic jitter and
random jitter.

Bandwidth expansion filter: The bandwidth of an AWG can be expanded further by applying the
bandwidth expansion filter which compensates for DAC roll-off. For example, when used with an
AWG7122B with option 06, the bandwidth expansion filter compensates for the DAC roll-off at higher
frequencies, thereby extending the bandwidth up to 9.6 GHz. This helps in improving the rise time.

Batch Processing: When more than one pattern needs to be synthesized, you can use batch processing
to create multiple waveforms with a combination of random and sinusoidal jitter with a maximum
of four different frequencies.

Overview Window: All jitter parameters can be switched on or switched off from the overview
window.
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Cascading S-Parameters: SerialXpress allows you to cascade up to six Touchstone files of the same
format to emulate a cascaded channel.

Sequencing: SerialXpress supports sequencing of several base pattern types. You can specify several
base pattern files, add different types of jitter to each base pattern, and compile them simultaneously.
These waveforms are automatically transferred to the AWG sequencer at the end of compilation.

Presets: SerialXpress provides pre-created setup files for standards such as SATA, USB 3.0,
DisplayPort, and HDMI. Selecting a preset loads the appropriate setup into SerialXpress.

Marker outputs: Marker outputs can be configured to be the same as the input base pattern or to
generate clocks at a user-defined frequency. You can also set the marker output to all high, all low,
or trigger.

Pre/de-emphasis and Preshoot: Standards like PCIE, 10 GbE, SAS, and USB 3.0 need more than one
tap for Pre/De-emphasis signal generation. The advanced Pre/de-emphasis feature of SerialXpress
provides flexibility to program the Pre/De-emphasis and Preshoot sample by sample. The preview
feature facilitates you to arrive at the most optimized Pre/de-emphasis for a particular channel quickly.

Crest Factor Emulation: SerialXpress allows you to apply peak pseudo random jitter to a bit pattern
and reduce your test time. The test cases can be repeated accurately so that the receiver can be
debugged quickly. SerialXpress allows you to accurately control the crest factor of the random jitter to
produce a worst case signal to stress the receiver.

Delay: SerialXpress allows you to introduce a delay into the waveform which can be used to generate
skew between channels or patterns.

Scrambling and 8B10B encoding: The input data pattern can be scrambled by defining a polynomial.
You can also encode using the 8B10B encoding option.

NRZ, NRZI, 4-PAM, and PWM: SerialXpress allows you to define the pattern duty cycle using the
Pulse Width Modulation (PWM), and alternatively encode the bit stream to 4-PAM, NRZ, or NRZI.
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Starting the Software

From the Start menu, click All Programs > Tektronix SerialXpress > SerialXpress. You can also
double-click the SerialXpress shortcut on the desktop.

Use the SerialXpress application in the following modes:

With AWG70000A Series instruments. SerialXpress is installed on a PC and connected to an
AWG70000A Series instrument via a LAN connection and the TekVISA communication software.

Run the SerialXpress AWG70000A Configuration Utility one time to use SerialXpress with an
AWG70000A Series instrument. The status bar shows AWG70XXX Offline.

SerialXpress on any AWG5000 or AWG7000 series instrument. In this case, the SerialXpress
automatically detects the AWG software. You can transfer data directly to the AWG software.

When SerialXpress is started on the PC without the AWG software running, SerialXpress does not
detect the AWG software. In this case, you cannot transfer data to the AWG (although you can create
and store the waveform for later use).

NOTE. The AWG5000 or AWG7000 software refers to the AWG memory manager and AWG Virtual
GPIB parser executables. The AWG user interface application and other executables are not necessary
but they may also be running.

Exiting the Software

Select File > Exit to exit the application. If you have not saved the waveforms, you are prompted to
do so. This option is always enabled.
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File Name Extensions and Directories

The application uses the following file name extensions:

Table 3: File name extensions

File name extension Description

.csv Ascii file containing Comma Separated Values. This file
format may be read by any ascii text editor (such as
Microsoft Notepad) or may be imported into spreadsheets
such as Microsoft Excel.

.sxs XML (Extensible Markup Language) file containing setup
information for creating a waveform.

.wfm Binary file containing an AWG waveform record in a
recallable, proprietary format.

.sxd Binary file containing an AWG waveform record in a
recallable, proprietary format.

.sxc Custom format binary file containing the calibration related
information.

.flt Files containing the inverse filter co-efficient.

.s1p

.s2p

.s4p

.s8p

Files that define 1-port, 2-port, 4-port, and 8-port
S-Parameters.

xxx

The application uses the following directories:

Table 4: Directory names

Directory Description

<Application installation path>\Tek-

tronix\SerialXpress\System
Contains the software executables, DLL files, sample
patterns, and Touchstone files.

<Application installation path>\Tek-

tronix\SerialXpress\Documentation
Contains the related documentation as text and PDF files.

<Application installation path>\Tek-

tronix\SerialXpress\Samples
Contains sample waveform files.

<Application installation path>\Tek-

tronix\SerialXpress\Samples\SATA
Contains sample base data files for patterns such as MFTP,
HFTP, and others in .txt format.

<Application installation path>\Tek-

tronix\SerialXpress\Samples\SAS
Contains sample base data files for patterns such as JTPAT
+ve disparity, JTPAT -ve disparity, and others in .txt
format.

<Application installation path>\Tek-

tronix\SerialXpress\Samples\HDMI
Contains sample base data files for patterns such as 480p 8
59 Gray RGB, 720p 8 60 Gray RGB, and others in .txt
format.
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Table 4: Directory names (cont.)

Directory Description

<Application installation path>\Tek-

tronix\SerialXpress\Samples\DisplayPort
Contains sample base data files for patterns such as DP
Training sequence2 960, CJTPAT, and others in .txt
format.

<Application installation path>\Tek-

tronix\SerialXpress\Samples\PCI-Express
Contains sample base data files for patterns such as
Compliance Pat and Clock in .txt format.

<Application installation path>\Tek-

tronix\SerialXpress\Samples\Fiber

Channel

Contains sample base data files for patterns such as
CJTPAT, JTPAT, and others in .txt format.

<Application installation path>\Tek-

tronix\SerialXpress\Samples\General
Contains sample base data files for patterns such as Clock,
PRBS7, and others in .txt format.

<Application installation path>\Tek-

tronix\SerialXpress\Samples\USB
Contains sample base data files for patterns such as CP0,
MinAdd1N, MinAdd1P, and others in .txt format.

<Application installation path>\Tek-

tronix\SerialXpress\Samples\User

Defined

This folder is empty. You can store the sample files that
you define in this folder.

<Application installation path>\Tek-

tronix\SerialXpress\Samples\Touchstone
Contains sample Touchstone files used with the
S-Parameter Filter.

<Application installation path>\Tek-

tronix\SerialXpress\Samples\Presets
Contains preset files for standards such as SATA, USB,
HDMI, and DisplayPort in .sxs format.

xxx
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Menu Bar

The SerialXpress menu has the following items:

File

Use the File menu to:

Restore the default setup for the currect active parameters.

Open a saved setup. The supported file is in .sxs format.

Save a setup in the .sxs format.

Save a setup under another name in the .sxs format.

Save data in .wfm format.

Import from file. The supported file is in DTG (Data Timing Generator) format.

Import data from a Tektronix oscilloscope.

Exit the application.
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View

Use the View menu to:

View or hide the toolbar. If the toolbar is hidden before closing the application, it remains
hidden when the application is opened again.

View or hide the status bar. If the status bar is hidden before closing the application, it remains
hidden when the application is opened again.

Configure

Use the Configure menu to:

Select the mode: Single or Sequence.

Find instruments that are connected on the network.

Waveform

Use the Waveform menu to:

Compile a new waveform file based on current settings.

Open the Compile Settings dialog box and define the compile options.

Open the Graph Setup dialog box and define the graph setup.
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System

Use the System menu to:

Set the AWG run mode to on. (AWG5000 and AWG7000 Series only)

Set the AWG run mode to off. (AWG5000 and AWG7000 Series only)

Turn all the channel outputs to on or off on the AWG. (AWG5000 and AWG7000 Series only)

Open the Calibration dialog box and set the parameters to calibrate the waveform.

Open the Option Installation dialog box and enable the function with an option (license) key.

NOTE. All these menu items except Option Installation are enabled when AWG software is running
along with SerialXpress. (AWG5000 and AWG7000 Series only)

Preset

Use the Preset menu to:

Load preset files for standards such as SATA, USB, HDMI, and DisplayPort.

NOTE. Presets are pre-created SerialXpress setup files for a standard.
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Window

Use the Window menu to:

View or hide the waveform list.

View or hide the graph window.

View or hide the instrument control window.

Open the Overview window.

Close all windows.

Help

Use the Help menu to:

Open the online help.

Display technical support contact information on the Tektronix Web site.

Display information about the application, such as version number.

Standard Toolbar

Select View > Standard toolbar to hide or show the toolbar. The toolbar is always displayed by default.

The Standard toolbar has the following options:

Mode (see page 20)

Calibration (see page 20)
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Overview (see page 22)

Find Instruments (see page 23)

Graph Setup (see page 23)

Compile (see page 25)

Compile Settings (see page 25)

On/Off (see page 28)

Run (see page 28)

Status Bar

Select View > Status Bar to hide or show the status bar. The status bar shows the selected application
and the AWG mode. The status bar is always displayed by default.

Waveform List

SelectWindow > Waveform List to view the waveform list. Waveform list is a floating window that
displays a list of all the waveforms. It can be moved anywhere in the display area. By default it is always
displayed and opens in the leftmost area of the display window.

After you select a pattern to generate and set the parameters for it, you must compile it to create the data.
Once you compile a waveform (using Compile from the toolbar), waveform data is created and added to
the waveform list. The Waveform list displays the Name, Length, Sampling Rate, and Time and Date
of the waveform data.

To save a waveform that is available in the list, select the waveform and select File > Save Data As. The
compiled waveform is saved as a data file (wfm) in the specified location. If there is no data to save, then
the Save Data As option is disabled.

NOTE. If you close the application without saving the compiled waveform, the waveform is lost. You can
compile the waveform again from the setup, if you have saved the setup using File > Save Setup or
Save Setup As.

You can select the following options from the shortcut menu:
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Table 5: Shortcut menu options and descriptions

Selection Description

Send to AWG Enabled only if the SerialXpress is connected to an AWG
instrument and when a waveform is selected. Sends the
selected waveform data to a Tektronix AWG. Select the
channel to which to send the data. The number of channels
and their state in the list depends on the model of AWG
and its current settings.

Show Graph Enabled only when a waveform is selected. You can select
Simulated Data Signal, Normal Eye, and Eye DPO graphs
from this option.

Save Data As Enabled only when a waveform is selected. Saves the
selected waveform data as a wfm file under the specified
name and location.

Import from Tektronix Oscilloscope (see page 33) Imports data from a Tektronix oscilloscope that is connected
to the instrument or PC on which the application is running.

Delete All Enabled only when one or more waveforms are available in
the Waveform List. Deletes all the waveforms shown in the
waveform list permanently.

Delete Enabled only when a waveform is selected. Deletes the
selected waveform permanently.

Rename Enabled only when a waveform is selected. Opens a dialog
box that allows you to enter a waveform name. When
a waveform name already exists, an error message is
displayed.

NOTE. All the properties of the waveform remain the same
except the waveform name.

xxx

SerialXpress User Manual 19



Operating Basics Mode

You can select multiple contiguous and non-contiguous waveforms using the Shift and Ctrl keys,
respectively. When you select multiple waveforms in the waveform list, the Show Graph, Save Data
As, and Rename options are disabled. Selecting multiple waveforms and the Delete option deletes all
the selected waveforms.

Mode

Click Configure > Select Mode in the toolbar to select the SerialXpress mode. This option is always
enabled.

SerialXpress operates in two modes: Single and Sequence. By default, Single mode is selected.

In the Single mode, you can select a set of patterns and compile jittered waveforms using these patterns.
However, each of these waveforms are independent. The waveform characteristics, such as disparity, phase
of periodic jitter, phase of SSC profile, and others are not carried over from one waveform to the next.
When a group of such waveforms are sent to the AWG sequence, the output of the AWG will have wrong
disparity and might have discontinuity in waveform or periodic jitter at the boundaries of the waveform.

In the Sequence mode, you can define the sequence before creating the waveform. It creates waveforms in
the same order as defined in the sequence table with the required waveform characteristics carried over
from one waveform to the next. The set of waveforms is then transferred to the AWG sequence. This
eliminates the effects of discontinuity between waveforms.

For more details, refer to Sequencing (see page 54).

Calibration

Click System > Calibration or Calibration in the toolbar to calibrate the waveform. This option is always
enabled. You can calibrate parameters like random jitter and periodic jitter.

NOTE. Calibration is not available in Sequence mode.

NOTE. Update the TekVISA resource manager before performing calibration. Only DPO70000 and
DSO70000 series oscilloscopes are listed.

You must select a base data file, and set the data rate and sampling rate for calibration.

Parameters such as data rate, base data file, sampling rate, and rise/fall time should not be changed. If
you change any of these parameters, you must recalibrate the setup.

You can save the calibration data as an sxc file.

A table displays a list of instruments on the network. The instrument model, status, connection type, and
name are shown but they are not editable. The following buttons are available:
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Table 6: Instrument setup buttons and their description

Button Description

Connect Connects to the instrument selected in the table and
updates the status to Connected in the table.

Disconnect Disconnects the instrument selected in the table and
updates the status in the table.

Test Connection Returns the current status of the selected instrument in the
table and displays the status as Connected (in green) or
Not Connected (in red).

Calibrate Starts calibration. The calibration status is displayed at the
bottom of the dialog box.

xxx

Click OK to apply the calibration data with “Apply calibration” option enabled in the Calibration
Setup dialog box. Click Cancel to abort calibration.

The Calibration Settings are as follows. All the calibration settings that are set in SerialXpress are updated
on the connected instrument.

Table 7: Calibration setup options and their description

Selection Description

DPOJet Settings Selecting Automatic sets up the DPOJet application on the
connected oscilloscope in the most optimal way. This is
useful for the simplest of calibrations.

Select Manual to set up DPOJet application manually.

For more details, refer to DPOJet Settings. (see page 104).

Save Saves the calibration setup file as an sxc file. You can also
select the path where the file is saved.

Load Loads a previously saved sxc file and displays the values
in the fields.

Apply calibration Enables calibration. When disabled, calibration data will not
be applied. You have to either load the calibration file from
disk using the "Load" option or recalibrate the application.

Enable SPC calibration on oscilloscope Enables SPC calibration on the connected oscilloscope.

Enable AWG channel calibration Enables AWG channel calibration.

xxx

The status of calibration process is shown at the bottom of Calibration dialog box.

Click Calibrate to start the calibration process.

At the end of the process, save the calibration data in a file specified in the file path. You can use Browse
to select a previously saved calibration file. Click OK for the changes to take effect without recalibrating.
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Overview

ClickWindow > Overview to display the overview window. A block view of the active waveform settings
appears in a new window. This window is a floating window and can be moved around the screen. Each
larger group in the diagram corresponds to a tab. This option is always enabled.

The Overview window has the following blocks:

The On/Off button to the right of each block corresponds to the check box for the group on the settings tab.
When the button is Off, the previous settings are retained but not used for Compile operation.

If the group does not have a check box, then On/Off button are not displayed on the block.

If the check box is disabled, the button text is Off (red).

If the check box is enabled, the button is On (green). The button on the block and the check box in the
group box are linked—if you change one, the change is reflected in the other.

For Periodic Jitter, if any of the periodic jitter parameters are selected in the Base Pattern tab, then the
corresponding button is On in the Overview dialog box.

When you click any block in the Overview dialog box, the corresponding parameter is highlighted in the
application and the Overview dialog box closes.
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Find Instruments

Click Configure > Find Instruments to view the find instruments window. You can find instruments
on the network and connect to them. This option is always enabled.

Table 8: Find instruments options and their description

Button Description

Connect Connect to the instrument selected in the table. Connect
is enabled by default if an instrument is highlighted in the
table; disabled if no instrument is highlighted.

Disconnect Disconnect the connected instrument. Enabled only if
highlighted instrument is connected.

Refresh Refresh the list of instruments.

Import (see page 33) Open the Import from Tektronix Oscilloscope dialog box to
select a file to import.

xxx

When the find instrument dialog box appears, the search for the instrument begins; the Connect button is
enabled after the search is complete.

Click Connect to connect to the selected instrument. The Status provides the current status during the
refresh operation: Searching Instruments or Ready.

Graph Setup

ClickWaveform > Graph Setup to view the graph setup window. This option is always enabled.

Graphs are created and updated as part of the Compile operation. You can display any two plots at a time.
The plots cannot be edited or saved. If you change any of the parameter values, you must compile again to
display the changes in the plot. You can maximize one plot at a time and zoom a selected area of interest.

The application allows you to select the types of graphs before creating them. The graphs are displayed as
a set in a small window (for preview). At any time, a maximum of two graphs can be displayed in the
small view.

To specify the graphs to create, click Graph Setup in the toolbar orWaveform > Graph Setup from
the menu bar. The Graph Setup dialog box opens.
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Follow these steps to select the graphs to create:

Highlight a graph from Available Graphs. Click Add to add the graph to the Selected Graphs area or
drag and drop the graph to the Selected Graphs area.

You can select the plots to display. SerialXpress supports the following plots:

Rise/Fall (see page 78)

Simulated Data Signal (see page 79)

Random Jitter (see page 80)

Periodic Jitter (see page 81)

Total Jitter (see page 82)

Normal Eye (see page 83)

Eye DPO (see page 84)

TIE (see page 85)

NOTE. By default, Simulated Data Signal and Eye DPO are selected. Once two graphs are added to
Selected Graphs, the application will not allow you to add any more graphs. You must remove a graph
before you can add another graph.
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To remove a graph, highlight a graph in Selected Graphs and click Remove in the Graph Setup
dialog box or Delete on the keyboard.

Click OK to view the graphs. The graphs are displayed in the Graph tab.

Compile

ClickWaveform > Compile to compile a currently active waveform.

The waveform is compiled and displayed in the Waveform List. You can save the waveform data as a wfm
file using the Waveform List (see page 18) shortcut menu. This option is not enabled when compilation is
in progress.

Compile Settings

ClickWaveform > Compile Settings to specify compilation settings for the currently active waveform
setup. This option is always enabled. This dialog box is displayed.
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Table 9: Compile settings options and their description

Selection Description

Waveform Name Enter the waveform name.

The waveform name is same as the pattern selected, except
for patterns such as User Defined. You can change the
waveform name either in the Compile Settings dialog box
or by using Rename option from the waveform list shortcut
menu.

Data Rate This option is not editable. The data rate is equal to the ratio
of Sampling Rate and Samples per UI.

Sampling Rate Enter the sampling rate (in S/s) of the waveform to compile.

Samples per UI Enter the samples per UI of the waveform to compile.

NOTE. If you change the sampling rate or samples per UI value, the rise/fall time values also changes.

Automatic Enable this to calculate the sampling rate. By default, this
is enabled. When disabled, you can change the sampling
rate or samples per UI.

In the offline mode, the sampling rate of the waveform (for
AWG7122B) is 24 GS/s. In the online mode, the sampling
rate of the waveform depends on the maximum sampling
rate of the instrument.

The minimum and maximum values of samples per UI are 2
and 240 respectively. When the value of samples per UI is
out of range, the sampling rate is automatically adjusted to
achieve the specified data rate.

Delay Specify the delay (in UI). This value is used to produce a
horizontal shift of the output signal by rotating the waveform
data.

In the Sequence mode, this option is available only when
Wrap between sequence elements is disabled.

Wrap between sequence elements Select this to enable wrap-around for all the sequence
elements.

When this option is disabled, the continuity of waveforms is
not ensured and the number of waveforms is equal to the
number of patterns.

Wrap between sequence elements (see page 97) ensures
continuity of the waveform sample when the sequence
execution moves from one sequence element to another.
The application may generate multiple waveforms in the
AWG corresponding to a single pattern in the SerialXpress.

Compile Button Preferences

Compiles and Sends To Select this to compile and send the waveform to the specified
channel. By default, Ch1 is selected. This option is enabled
only when the SerialXpress is running in the online mode.

Compiles Only Select this to compile the waveform without sending it to the
AWG. The compiled waveform is displayed in the waveform
list.
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Table 9: Compile settings options and their description (cont.)

Selection Description

Repeat 1

Automatic When enabled (default), the repeat is set to automatic.

The repeat is calculated based on the Pj, Rj, and SSC
frequency values.

Manual Enable this to manually set the repeat in count or secs.

The minimum and maximum values depend on the following
parameters:

Input pattern size (that is, total number of bits)

Current SPUI (Samples Per UI) value

The maximum value is calculated depending on the memory
availability.

The minimum and default values are calculated depending
on the minimum number of samples required by the AWG
(960 samples), Pj, Rj, and SSC frequency values.

NOTE. Repeat options are disabled in the Sequence mode.

Bandwidth Expansion Filter 2

Interleave Off Select Bandwidth Expansion Filter to enable this option.
This option is available only when the sampling rate is less
than 12 GS/s (for AWG7122B and AWG7122C).

Interleave without Zeroing Select this to apply the bandwidth expansion filter if zeroing
is off. This option is available only when the sampling rate
is greater than or equal to 12 GS/s (for AWG7122B and
AWG7122C).

Interleave with Zeroing Select this to apply the bandwidth expansion filter if zeroing
is on. This option is available only when the sampling rate
is greater than or equal to 12 GS/s (for AWG7122B and
AWG7122C).

Batch Compile (see page 28) Select this to activate batch compilation.

Batch Setup Select this to set the values to be used for batch creation.

Show Graph after Compile Select this to display the graphs after compilation. The
compiled graph is displayed using Graph Setup dialog box.
When disabled, no plot is displayed after compilation and
the compilation time is reduced.

Overwrite Waveform in SerialXpress List Select this to overwrite a waveform in the list with the
compiled waveform. When disabled, you are prompted that
a file of the same name exists.

xxx

1 Repeat determines the number of times the input pattern repeats before generating the waveform. This allows you to determine the optimum
waveform size for best results.

2 The bandwidth expansion filter is used to improve the performance of the AWG when the rise time is very high. For better use of the bandwidth
expansion filter, set the rise time to less than 80 ps for AWG7122B and AWG7122C.
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NOTE. When Automatic option is enabled, the Sampling Rate and Samples per UI options are disabled.

The Compile and Sends To and Compile Only options are disabled when SerialXpress is in the offline
mode. Click Compile to compile the waveform. The compiled waveform is displayed in the waveform list.

In the Sequence mode, all the options except forWaveform Name, Delay, Overwrite Waveform in
SerialXpress List, Show Graph after Compile, Repeat, and Batch Compile options are disabled.

On/Off

Click On/Off to turn on or turn off the AWG channel output. This option is enabled when
SerialXpress is running in the online mode (for AWG7000 and AWG5000 series).

Run

Click Run to turn on or turn off the Run state of the AWG. If the application is running on an
AWG or using an offline mode of the AWG software, then the compiled waveform is directly output to the
channel and indicated by changing the Run button to green. This option is enabled when SerialXpress is
running in the online mode (for AWG7000 and AWG5000 series).

Batch Process

Click Batch Setup from Compile Settings > Batch Compile > Batch Setup to set up the batch process.
This option is disabled by default.

Batch Process creates multiple waveforms with a combination of random jitter and periodic jitter with a
maximum of four different frequencies with user-defined parameter increments.

Clicking Compile starts batch compilation when Batch Compile is enabled. This dialog box is displayed
upon clicking Batch Setup.

NOTE. When you navigate the batch compile through Compile Settings, theWaveform Name, Compile
Button Preferences, and Show Graph after Compile options are disabled.
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By default, both Random Jitter and Periodic Jitter are enabled where you can set the values to be used
for batch creation. When you disable both the options and click Compile, the following error message
appears: The parameter values do not generate any waveform.

The following condition occurs when Random Jitter (Rj) and/or Periodic Jitter (Pj) values are same in both
the Batch Setup Compile dialog box and Transmitter tab:

When either Rj or Pj is disabled in the Batch Setup Compile dialog box but enabled in the
Transmitter tab, the corresponding value set in the Transmitter tab is used for compilation.

When either Rj or Pj is disabled in both Batch Setup Compile dialog box and Transmitter tab, the
value zero is used for compilation.

The following condition occurs when Random and/or Periodic Jitter have different values set in the Batch
Setup Compile dialog box and Transmitter tab:

When Batch Compile is enabled in the Compile Settings dialog box, the values set in the Batch
Setup Compile dialog box are used for compilation.

When Batch Compile is disabled in the Compile Settings dialog box, the value set in the Transmitter
tab is used for compilation.

NOTE. The Batch Compile option is available only for a single file. It cannot be applied when multiple
pattern files are selected.
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Table 10: Batch Compile Setup options and their description

Selection Description Range, Default value

Random Jitter (RMS)

Start Set the random jitter start value (in UI). 0 UI to 0.5 UI, 0 UI

End Set the random jitter end value (in UI). 0 UI to 0.5 UI, 0 UI

Increment Set the random jitter increment value
(in UI).

0 UI to 0.5 UI, 0.01 UI

Periodic Jitter (Pk-Pk)

Start Set the periodic jitter start value (in
UI).

0 UI to 50 UI, 0 UI

End Set the periodic jitter end value (in UI). 0 UI to 50 UI, 0 UI

Increment Set the periodic jitter increment value
(in UI).

0 UI to 0.5 UI, 0.01 UI

Sine 1

Frequency 1 Set the first periodic jitter frequency
(in Hz).

10 kHz to Data rate/2, 10 MHz

Frequency 2 Set the second periodic jitter frequency
(in Hz).

10 kHz to Data rate/2, 0 Hz

Frequency 3 Set the third periodic jitter frequency
(in Hz).

10 kHz to Data rate/2, 0 Hz

Frequency 4 Set the fourth periodic jitter frequency
(in Hz).

10 kHz to Data rate/2, 0 Hz

xxx

NOTE. When the same frequency value is used more than once in the Periodic Jitter, only one frequency
is used for compilation. If the value zero is set, that frequency is not used for compilation. Only Sine1
Frequency 1 is used for compilation.

Click OK to save the changes and Compile to compile the waveform. The waveform name format is
“Rj<value>Pj<value>Freq<value>”.

For Example: Rj0.2Pj0.1100000 means Rj of 0.2 UI, Pj of 0.1 UI applied on a frequency of 10 kHz.
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Option Installation

Click System > Option Installation to use the SerialXpress application to generate, transfer, and save
the waveforms. Once the trial (see page 1) expires, you cannot transfer or save the waveform unless you
enable the function with an option (license) key.

Click System > Option Installation. This dialog box is displayed.

Table 11: Option installation information and their description

Selection Description

User Name Enter the user name.

Option Key String Enter the 20 digit option key string that is provided along
with the application.

Option Information The option information is displayed in the table.

xxx

Click Copy Option Info to copy the information in the table to the clipboard. Click Apply to apply
the entered values.
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Restore Default Setup

Click File > Restore Default Setup to restore the default values of all the parameters. This option is
always enabled.

Clicking Save stores the current settings into a folder in .sxs format and restores the default settings.

Open Setup

Click File > Open Setup to browse to open a saved setup file.

All files have the file name extension sxs. This option is always enabled.

Save Setup

Click File > Save Setup to save the setup file in the .sxs format.

Use File > Save Setup to save an existing setup file with the same name. If you are saving the setup for the
first time, the Save Setup option works exactly as the Save Setup As option. This option is always enabled.

Save Setup As

Click File > Save Setup As to save the data file in .sxs format.

You must compile a setup before you can save the data. If you try to save a setup without compiling, you
are prompted to compile the setup. This option is always enabled.

Import from File

Click File > Import from File to import a pattern file created in another application, and add these patterns
into SerialXpress. This option is always enabled.

You can import only DTG files.
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Import from Tektronix Oscilloscope

Click File > Import from Tektronix Oscilloscope to import a waveform file from a Tektronix
oscilloscope that is connected to your AWG into SerialXpress. This dialog box is displayed. This option is
always enabled.

A table displays a list of oscilloscopes on the network. Select an oscilloscope in the table and click
Connect to connect to it. You can connect more than one oscilloscope but can calibrate only one at a time.
Click Disconnect to disconnect from an oscilloscope.

For a connected oscilloscope, you can set the following parameters:

Table 12: Waveform import options and their description

Selection Description Default value

Data Source Select the data from which to acquire
the waveform data: Ch1 to Ch4,
Math1 to Math4, and Reference1 to
Reference4.

Ch1

Acquisition Mode Set the acquisition mode to one of
the following: Samples, Peak Detect,
Envelope, or Average.

Samples
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Table 12: Waveform import options and their description (cont.)

Selection Description Default value

Waveform Name Specify the waveform name. The
imported waveform is saved in the
specified name.

N/A

Record Length Displays the record length of the
selected oscilloscope. Change the
record length by entering a new value
in the field.

N/A

xxx

Click Acquire to import the data. The specified waveform name is used to list the waveform in the
Waveform List.

PRBS Editor

This dialog box is displayed upon clicking PRBS Editor when Standard is set to General, and Pattern to
User-Defined in the Base Pattern tab.

This data source can generate different pseudo-random binary sequences. The available PRBS patterns
are: PRBS 7, PRBS 9, PRBS 15, and PRBS 16.

PRBS sequences are generated by a feedback shift register. The accepted value of the shift register text
boxes is 1 or 0. The number (#) following PRBS indicates the length of the generating shift register.
For instance, a shift register with 16 memory cells is required to generate a PRBS 16 sequence. The
pseudo-random sequence of a PRBS generator is determined by the number of registers and the feedback.
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Table 13: PRBS editor options and their description

Selection Description Default value

PRBS polynomial expression Enter an expression in the format
Xn1+Xn2+1 to generate the
pseudo-random sequence. The value
of Xn ranges between 1 and 31.

X7+X6+1

Shift register initial value D1– D31 Enter values in the shift registers to
create the sequence. The registers
D1 through D31 can take the values
0 and 1.

D1– D31

xxx

NOTE. SerialXpress does not support patterns of all zeroes when the user-defined PRBS equation is
selected.

Click Apply to effect the changes. Click Reset to Default to restore the editor to the default values.

For more details, refer to PRBS Editor Starting Values (see page 91).

Pre/De-Emphasis and Preshoot Advanced Setup

This dialog box is displayed upon clicking Advanced Setup when Pre/De-emphasis is selected in the
Transmitter tab. For more details, refer to Pre-Emphasis (see page 100).
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Table 14: Pre/De-emphasis and preshoot advanced setup options and their description

Selection Description Default value

Settings

Option Select the required option to use.
The available selections are:
Pre/De-emphasis only, Preshoot only,
and Pre/De-emphasis & Preshoot.

Pre/De-emphasis only

Samples per Unit Interval (SPUI) Displays the samples per UI that is set
in the Compile Settings dialog box but
the value is equal to floor (SPUI).

For example, if the SPUI value set in
the Compile Settings dialog box is 3.4,
the value used here is 3.

—
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Table 14: Pre/De-emphasis and preshoot advanced setup options and their description (cont.)

Selection Description Default value

Type Select the type to use. The available
selections are:

UI-constant: Pre/De-emphasis is
applied to all the samples in the UI.

UI-Linear: Pre/De-emphasis is
applied to all the samples in the UI
linearly.

Fractional: Pre/De-emphasis is
applied to a fraction of the UI.

UI-constant

Units for Tap Co-efficients Select the units in which the
tap-cofficients will be specified (dB
and Volt).

The tap co-efficients defines
the incremental voltage on the
pre-emphasized bit.

For dB, the value ranges from –20 dB
to +20 dB.

For Volt, the value ranges from –0.9 V
to +9.0 V.

dB

Pre/De-Emphasis and Preshoot tabs

Pre/De-Emphasis Specify the number of taps and the
tap coefficients.

NOTE. This tab is not available when
Preshoot only option is selected.

—

Preshoot The number of taps is fixed to 1 and
you cannot specify the number of
taps. However, you can specify the
tap coefficients in the Tap-coefficients
table.

NOTE. This tab is not available
when Pre/De-emphasis only option
is selected.

—

NOTE. For Pre/De-emphasis and Preshoot option, the number of taps for Pre/De-emphasis is limited to 1.

Preview The application computes and
displays the waveform based on the
pre/de-emphasis and/or preshoot
settings.

—

Reset All the tap co-efficients in the table are
set to 0.

—

xxx
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Setting the Base Pattern

Base data is always in the form of zeroes and ones. Base data can be of two types:

Standard patterns (such as SATA, HDMI patterns) provided as part of the SerialXpress application

User created patterns

When you select User Defined patterns, you might need to encode them. SerialXpress supports common
encoding techniques such as 8B10B, NRZ, NRZI, and 4-PAM (see page 102).

NRZI (no-return to zero inverted), where “0” indicates no change and “1” indicates the current level.
If the current waveform is high, a “1” bit value causes a transition to the low waveform level. If the
current waveform level is low, a “1” bit value causes a transition to the high waveform level. Refer to
the following example.

8B10B is used to encode an 8-bit data to a 10-bit data. This is the most common encoding mechanism
used for Serial data standards. For example SATA patterns are 8B10B encoded.

NRZ (no-return to zero), where “0” indicates low value and “1” indicates high value.

Encoding is a process by which input patterns (zeroes and ones) are modified to different patterns (again
zeroes and ones in various combinations).

To define the base pattern and source, waveform characteristics, encoding scheme, and rise/fall time
parameters, do the following:

1. Set the base pattern. This can be done using one of the following methods:

NOTE. Use the Invert Bits option in all three methods to create an inverted signal. For example, an input
bit stream of 011000 will create a signal of 100111 when the Invert Bits option is enabled.
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Method 1: Selecting the Standard Base Pattern

Select the standard from the list: SATA, SAS, Display Port, PCI-Express, Fiber Channel, General,
USB, and MIPI.

Select the pattern from a file. The available options depend on the selected standard as follows:

NOTE. The General standard and Clock pattern are the default settings.

Table 15: Standard and Pattern options

Option Pattern selections Default

SATA The selections for SATA are: MFTP,
HFTP, SFCP4AlignR12, and others.

MFTP

SAS The selections for SAS are:
JTPAT_RD+ , JTPAT_RD–, and
others.

JTPAT_RD+

DisplayPort The selections for DisplayPort
are: DP Training sequence2 960,
PRBS7, and others.

PRBS7

PCI-Express The selection for PCI-Express are:
Compliance Pat and Clock.

CompliancePat

Fiber Channel The selection for Fiber Channel are:
CJTPAT, JTPAT, and others.

CJTPAT

General The selections for General are:
Clock, PRBS7, PRBS9, and others.

Clock

This pattern has a high frequency
clock, such as 1,0,1,0,1,0,...

USB The selections for USB are: CP0,
MinAdd1N, MinAdd1P, and others.

CP0

MIPI The selections for MIPI are:
CJTPAT_FC and Clock.

CJTPAT_FC

xxx

Method 2: Selecting the From File Base Pattern

Browse to select a file from which to take the pattern. The file format is txt.

SerialXpress supports:

Selecting a single pattern file from mass storage. See Creating the Base Data (see page 48).

Selecting multiple pattern files from mass storage. See Creating the Base Data (see page 48).

40 SerialXpress User Manual



Creating a Signal Setting the Base Pattern

NOTE. Selecting single or multiple pattern files allows you to encode the selected data. You can skip
encoding if it is not required.

When multiple pattern files are selected, the encoding type applies to all the selected pattern files.

Selecting from a list of pattern data supplied with the application.
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Method 3: Selecting a User Pattern

Select any of the User Pattern formats: Binary, Hex, or Symbol. By default, Binary is selected.

Enter the pattern in the text box.

You can enter up to 20 zeroes, ones, and z's. To enter more than 20 digits, click Editor. In the
User Pattern Editor dialog box, enter up to 128 digits for Hex mode, 512 digits for Binary mode,
and 64 symbols for Symbol mode.

NOTE. When the pattern file contains ‘z’, no encoding, scrambling, or distortions are applied.

The format for Symbol mode is Dxx.y or Kxx.y. The first character is either D or K.

You can enter up to 64 symbols, each separated by a comma.

For the D character, the value of x is in the range 0 to 31 and y is in the range 0 to 7.

For the non-encoded K character, the values of x and y are as follows:

K28.0 = 00011100

K28.1 = 00111100

K28.2 = 01011100

K28.3 = 01111100

K28.4 = 10011100

K28.5 = 10111100

K28.6 = 11011100

K28.7 = 11111100

K23.7 = 11110111

K27.7 = 11111011

K29.7 = 11111101

K30.7 = 11111110
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2. Set the following scrambling parameters:

Table 16: Scrambling 1 options and their description

Option Description Default

Scrambling Set this option to enable scrambling. Disabled

Polynomial Specify the scrambling polynomial
expression. You can enter up to 256
characters.

This option is available only if the
Enabled option is selected.

This contains a polynomial expression
such as X16+X14+1. If the
polynomial format is incorrect, an
error is displayed. The polynomial
expression is standard-specific.

X16+X5+X4+X3+1

Register Initial Value Specify the register initial values and
select the format (Hex or Binary).

The length of the register is equal to
the degree of the polynomial.

1111111111111111

xxx

1 Scrambling is used to ensure that the input data stream has sufficient number of transitions. It is used in standards like SATA and USB 3.0.

The SerialXpress application requires a scrambling polynomial as specified by the standard. The standard also specifies the size of the register
(such as 16 bits or 32 bits) and initial state of the register. Scrambling is done on each bit of the input stream. The receiver has to unscramble the
data to retrieve the original bit stream.

NOTE. The K symbols are not scrambled.

3. Set the following PWM parameter.

Table 17: Encoding options and their description

Option Description Default, Range

PWM Select PWM to generate a pulse width
modulated signal.

For more details on PWM, refer
to Pulse Width Modulation (see
page 102)

Disabled

T_Minor

In PWM each bit consists of a negative
state followed by a positive state.
T_Minor specifies the negative state
of the bit (in UI).

Enter the T_Minor value (in UI).

NOTE. This option is enabled only if
PWM is selected.

0 UI to 0.5 UI, 0.33 UI

xxx

4. Select the following encoding scheme:
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Table 18: Encoding options and their description

Option Description Default

Scheme Select the encoding scheme to use:
NONE (NRZ), NRZI, or 4-PAM.

NOTE. The 4-PAM symbol can
accept input data only in binary
format. The length of the input pattern
must be an even number.

For more details on PAM, refer to
Pulse Amplitude Modulation (see
page 102)

None

8B10B Select 8B10B to encode an 8-bit data
to 10-bit data.

Disabled

Disparity

Disparity refers to starting disparity.

Select the disparity: Positive or
Negative.

NOTE. This option is enabled only if
8B10B is enabled.

RD+

xxx
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5. Set the following signal characteristics:

Table 19: Signal characteristics and their description

Option Description Range, Default value

Data Rate Specify the data rate (in bps) of the
waveform.

Range:

500 Kbps to 50 Gbps (AWG70001)

500 Kbps to 25 Gbps (AWG70002)

500 Kbps to 6 Gbps (AWG7000B and
AWG7000C without interleave)

500 Kbps to 12.0 Gbps (AWG7000B
and AWG7000C with interleave)

500 Kb/s to 3300 Mbps (AWG5000)

500 Kbps to 12 Gbps (Offline)

Default: 1 Gbps

Idle State Enter the idle state value (in samples
or secs) of the waveform.

Idle state is the state used for some
standards like SATA. During this state,
the value is neither 0 nor 1. It is a
state during which no valid data is
transferred between the transmitter
and the receiver. SerialXpress
supports Idle state waveforms with
idle value and idle offset.

Idle state waveforms are individual
waveforms that can be sent to the
AWG. Use the sequence mode to
take the receiver to the idle state. The
waveforms contain the DC values
with no base data during this state.
You can add the number of samples
and noise as required in the idle state
waveform.

53 ns to 100 μs, 320 ns

xxx

The default data rate changes depending on the selected standard. You can change the data rate if
necessary. The following table lists the default data rate for various standards.

Table 20: Signal standards and their default data rates

Signal standards Data rate

SATA 3 Gbps

SAS 3 Gbps

DisplayPort 2.7 Gbps

PCI-Express 5 Gbps

Fiber Channel 4.25 Gbps
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Table 20: Signal standards and their default data rates (cont.)

Signal standards Data rate

USB 5 Gbps

MIPI 3 Mbps

xxx

NOTE. When you select Idle State, all the parameters in the Encoding, Scrambling, Rise/Fall groups,
Transmitter tab, and Channel/Cable tab are disabled.

6. Set the following offset parameter:

Table 21: Offset option

Option Description Default

Idle State Offset Enter the idle state offset value (in
Volts) of the waveform.

This is available only when Pattern is
set to Idle state.

–0.5 V to +0.5 V, 0 V

xxx

7. Set the following amplitude parameters:

Table 22: Amplitude options and their description

Option Description Default

Maximum Specify the maximum amplitude (in
volts) of the waveform.

+0.5 V to –0.25 V

Default:

+0.5 V (Offline)

Depends on the maximum amplitude
value of the AWG (Online)

Minimum Specify the minimum amplitude (in
volts) of the waveform.

+0.25 V to –0.5 V

Default:

–0.5 V (Offline)

Depends on the maximum amplitude
value of the AWG (Online)

xxx

SerialXpress can generate waveforms that occupy only a part of the full DAC range of the AWG. By
default, the generated waveforms occupy the whole DAC range. When SerialXpress is in the online
mode, the maximum voltage corresponds to the full DAC of the AWG on which it is running. When
SerialXpress is in the offline mode, the maximum range is assumed to be 1 Vpp (peak-to-peak).

8. SerialXpress allows both equal and unequal rise and fall times. Set the following rise/fall time
parameters:
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Table 23: Rise/Fall Time options and their description

Option Description Range, Default value

Rise/Fall Time Set the Rise/Fall time option to 10/90
or 20/80. This defines whether rise
and fall times are calculated using
10/90 or 20/80 ratio.

10/90 or 20/80, 20/80

Rise Set the rise time in s or UI. The rise
time is used to define how steep the
rising slope will be.

Range:

0.6/sampling rate to 0.6/data rate

Default: 100 ps

DCD Set the DCD in s or in UI.

When DCD is disabled, the rise and
fall times can be controlled. When
DCD is enabled, the rise and fall times
are calculated separately to achieve
the required DCD.

0 UI to 1 UI, 0 UI

Fall Set the fall time in s or UI.

When fall time is enabled, DCD is
calculated internally. When DCD
is enabled, the fall time value is
calculated internally.

Range:

0.6/sampling rate to 0.6/data rate

Default: 100 ps

xxx

When you change the unit for rise and fall times from UI to secs, or secs to UI, the value of rise and
fall time changes to reflect their equivalent in the new unit.

A unit interval (UI), also referred to as a bit time, is the time taken in a data stream for one bit. For
example, in a serial line with a baud rate of 2.5 Gb/s, a unit interval is 1/(2.5 Gb/s) = 0.4 ns/bit.

9. Set the following marker parameters:
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Table 24: Marker Settings options and their description

Option Description Default value

Base pattern Select this option to set the marker
output to be the same as the base
pattern.

Enabled

Clock Select this option to set the marker
output to be same as the selected
clock type. You can select the clock
from the available options.

If you have selected the clock as
User Defined, you can change the
frequency.

NOTE. If the frequency that you
have entered is not a factor of the data
rate, the marker may not synchronize
with the rising edge of each data bit.

Disabled

High/Low Select this option to set the marker
output to all high, all low, or trigger.

Selecting Trigger sets the beginning N
samples of the waveform to high.

N is the number of specified samples.

Disabled

xxx

Creating the Base Data

Selecting a pattern file from mass storage

The pattern format is as shown:

NOTE. The file format is txt. If a pattern file does not have the specified data in any row or data bit
as follows, then the waveform generation fails.

Row<1> D1 D2 D3 D4 D5 D6 D7 D8 D9 D10<CR><LF>

Row<2> D11 D12 D13 D14 D15 D16 D17 D18 D19 D20<CR><LF>

Row<3> D21 D22 D23 D24 D25 D26 D27 D28 D29 D30<CR><LF>

………………………………………………………….......<CR><LF>

Row<n>…………………………………………………....<CR><LF><EOF>

where,

Row<n> refers to row number.

D30 to D1 refers to data bits with the values 1 or 0.
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<CR> refers to carriage return.

<LF> refers to line feed.

<EOF> refers to end of file.

NOTE. Row number and EOF do not appear as part of the file.

<CR> and <LF> together can be considered as the end of line.

Selecting single or multiple pattern files allows you to encode the selected data. You can skip the encoding
if not required.

NOTE. When multiple pattern files are selected, the encoding type applies to all the selected pattern files.

File format for 8-bit data.

<D1>,<D2>,<D3>,<D4>,<D5>,<D6>,<D7>,<D8>,<M1>,<M2><CR><LF>

<D11>,<D12>,<D13>,<D14>,<D15>,<D16>,<D17>,<D18>,<M1><M2><CR><LF>

where, <M1>,<M2> are the marker bits.

The file format for 8-bit data is as follows:

NOTE. You can replace 0 and 1 with ‘z’.
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File format for 10-bit data.

<D1>,<D2>,<D3>,<D4>,<D5>,<D6>,<D7>,<D8>,<D9>,<D10><CR><LF>

<D11>,<D12>,<D13>,<D14>,<D15>,<D16>,<D17>,<D18>,<D19>,<D20><CR><LF>

The file format for 10-bit data is as follows:

NOTE. You can replace 0 and 1 with ‘z’.

Annotated text file format.

The following is an example of an annotated file format:

<D1> /Comment <CR><LF>

<D2><D3><D4> /Comment <CR>

<D5><D6> /Comment <CR><LF>

<D7><D8><D9><D10> /Comment <CR><LF>

The value of Dx is either 0, 1, or ‘z’, where ‘x’' is an integer number indicating the bit number.

The annotated text files contains any number of bits or ‘z’ characters per line and comments.

‘/’ indicates the start of the comment. Any data or text after the ‘/’ character is ignored.

File format for symbol data.

<Symbol><CR><LF>

<Symbol><CR><LF>

<Symbol><CR><LF>

<Symbol><CR><LF>

<Symbol><CR><LF>
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Annotated file format for symbol data.

<Symbol> /Comment<CR><LF>

<Symbol> /Comment<CR><LF>

<Symbol> /Comment<CR><LF>

NOTE. By default, all the symbols are assumed to be 8-bit non-encoded data. Use encoding to encode
symbol data. By default, the NRZ encoding scheme is selected. When 8B10B encoding is selected along
with the other encoding (NRZ, NRZ1, or 4-PAM), the 8B10B encoding will be applied last.

When any encoding other than 8B10B is applied to a user pattern file containing D and K characters, the
application cannot distinguish between these characters. In such cases, all the characters are assumed to
be D.

The following format is selected as input to the SerialXpress, when both NRZI and 8B10B encoding
are selected:

D28.5

D16.3

D13.3

K28.5

The output file format is as follows:

D28.5

D16.3

D13.3

D28.5

The final output will have all D characters.

If only the 8B10B encoding is selected, the application generates the output for K28.5.

NOTE. When the pattern file contains ‘z’, no encoding is applied.

Calibration for Base Pattern Signals

Calibration is available under the following conditions:

When the SerialXpress is running on an AWG7000 or AWG5000 series instrument, or

When configured and connected to AWG70000A series instrument.

SerialXpress User Manual 51



Creating a Signal Calibration for Base Pattern Signals

For Base Pattern waveforms, connect the AWG and oscilloscope as follows (AWG7000 series instrument
with interleave option):

The rear panel connections of an AWG7000 or an AWG5000 series instrument and an oscilloscope are
as shown:
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The rear panel connections of an AWG70000 series instrument and an oscilloscope are shown:

Creating Calibration Data

1. Select Calibration from the toolbar.

2. From the list of instruments, highlight an oscilloscope and click Connect.

3. Set the Calibration parameters. For more details, refer to Calibration (see page 20).

4. Click Calibrate. A status message displays the status of processing.

The files (sxc) created contains calibration data.
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Setting the Sequence Parameter

SerialXpress operates in two modes: Single and Sequence. By default, Single mode is selected.

NOTE. Calibration is not supported in Sequence mode.

About Sequencing

In the Single mode, you can select a set of patterns and compile jitter waveforms using these patterns.
However, each of these waveforms are independent. The waveform characteristics, such as disparity, phase
of periodic jitter, phase of SSC profile, and others are not carried over from one waveform to the next.
When a group of such waveforms are sent to the AWG sequence, the output of the AWG will have wrong
disparity and might have discontinuity in waveform or periodic jitter at the boundaries of the waveform.

Using sequencing, you can resolve this problem. SerialXpress lets you define the sequence before creating
the waveform. It creates waveforms in the same order as defined in the Sequence table with the required
waveform characteristics carried over from one waveform to the next. The set of waveforms is then
transferred to the AWG sequence. This eliminates the effects of discontinuity between waveforms.

Sequence Mode

When you select the Sequence mode, a table is displayed. Use the sequence table to set the waveforms for
the channel in a sequence and generate waveforms one after the other depending on the sequence. Click
Add to add a sequence element to the table. You can add up to 1000 sequence elements. When the number
of sequences exceeds the limit, an error message is displayed and the software does not allow you to add
any more rows. You must remove a sequence row before you can add another sequence element.

When you switch to the Single mode, the contents of the table are carried over. The sequence settings are
restored when you return to the Sequence mode.

Table 25: Sequence table options

Control Description State Default value

Index This column indicates
the order in which the
waveform will be output
from the channel.

Read only Blank

Base Pattern This column shows the
selected base pattern for
each sequence.

Read only Blank

The pattern selected in the
base pattern is displayed.

Wait This column allows you to
set the wait to On/Off.

If you set the wait to On,
the sequencer waits for the
trigger before generating
the waveform.

Read/Write Blank

This parameter is set to Off
when you add a sequence
element.
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Table 25: Sequence table options (cont.)

Control Description State Default value

Repeat Mode This column allows you
to set the repeat mode
to auto, manual count,
manual time, or infinite.

When you select Auto,
the repeat count column
is disabled and the value
in that column is not
considered for compilation.
Optimal value for repeat
count is calculated by the
application.

When you select Manual
Count, the repeat column
is enabled and is set to 1
(by default).

When you select Manual
Time, the repeat column
is enabled and you can
specify the waveform
duration in seconds.

When you select infinite,
the repeat column is
disabled and repeat is set
to infinite.

Read/Write Blank

This parameter is set to
Auto when you add a
sequence element.
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Table 25: Sequence table options (cont.)

Control Description State Default value

Repeat This column shows the
repeat count currently
selected.

This option is available only
when the Repeat mode is
set to Manual.

The minimum and
maximum repeat counts
are 1 and 1 M.

Read only, when the
Repeat mode is set to Auto
or Infinite.

Read/Write, when the
Repeat mode is set to
Manual Count or Manual
Time (s).

Blank

1 is displayed when you
add a sequence element to
the list.

Go To This column shows the Go
To target number.

You can specify a Go To
target for each sequence
element. The sequencer
jumps to the element
specified as the Go To
target.

If the Go To target is not
specified, the sequencer
moves to the next element.

The Go To target number
should not be greater than
the sequence length. The
number must be a positive
integer starting from 1.

Read/Write Blank.

You can edit this column
only if there is a sequence
element in the list.

xxx

The following buttons are available for the Sequence mode:

Up and Down Arrows: Moves a selected sequence element up or down the table.

Add: Adds the sequence element at the end of the sequence table with the parameters as set in the
Base pattern, Transmitter, and Channel/Cable tabs.

Add multiple files: Allows you to add multiple files to the sequence table.

Batch Setup (see page 28): Enables batch compilation. When you click the button, you can set the
values to be used for batch creation and specify the sequence index to which the batch process should
be applied.

The following options are available when you right-click on the selected row in the table:

Cut: Cuts the selected rows.

Copy: Copies the current selected row.

Paste: Pastes the contents from memory on to the selected row and replaces the selected row.

Insert: Inserts a copied sequence element with the selected row data below a selected row.
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Delete: Deletes the selected row.

Delete All: Deletes all the rows in the table.

Setting Jitter Parameters

Click Transmitter tab to add periodic and random jitter to the waveform that you want to create. To
add jitter, do the following:

1. To introduce one or more sine waves as periodic jitter, enable one or more check boxes. Set the
Magnitude (UI), Frequency (Hz), and Phase (°) for each.

Table 26: Setting periodic jitter parameters

Option Description Range, Default

Magnitude Set the magnitude of the sine wave
(jitter) (in UI) to introduce.

0 UI to 50 UI, 0 UI

Frequency Set the frequency of the sine wave
(jitter) (in Hz) to introduce.

10 kHz to Data rate/2, 10 MHz

Phase Set the phase of the sine wave (jitter)
(in degrees) to introduce.

0 ° to 360 °, 0 °

xxx

For examples on periodic jitter, refer to Periodic Jitter Sample Test Results (see page 108).

2. To add one or more random jitters, enable one or more check boxes. Set the Magnitude (UI),
Frequency-Low (Hz), and Frequency-High (Hz) for each.
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Table 27: Setting random jitter parameters

Option Description Range, Default

Random Seed Set this option to use the same
random jitter sequence during each
compilation. The required random
jitter sequence is generated through
a 5-digit seed. By keeping the 5-digit
seed constant, the same random jitter
sequence is generated during each
compilation.

When disabled, the uncorrelated
random jitter sequence is generated
during each compilation.

1 to 99999, 12345

Rj1 Crest Factor (Peak) Set this option to apply the required
crest factor value of Rj1 to the serial
data. This value can be applied only
to Rj1.

When you enable Rj1 with a specified
RMS value within a short signal
duration, it will not reach the peak
value. By enabling this, a required
crest factor value of Rj1 is applied
to the serial data during data
transmission.

For example, if the Rj1 crest factor is
set to 12 and magnitude (RMS) for
Rj1 is 0.05 UI, then the Rj1 peak value
is 12 x 0.05 = 0.6 UI.

1 to 20, 12.732

Magnitude Set the RMS magnitude of the random
jitter (in UI) to introduce.

0 UI to 0.5 UI, 0 UI

Frequency-Low Set the low frequency of the random
jitter (in Hz) to introduce.

1 Hz to (Frequency-High – 1 M),
100 kHz

Frequency-High Set the high frequency of the random
jitter (in degree) to introduce.

1.1 MHz to Data rate/2, Data rate/2

xxx

The random jitter generated through a random sequence is independent for each compilation.

3. To specify SSC parameters, select SSC and set the following parameters:

Table 28: Setting SSC parameters

Option Description Range, Default value

Shape Select the shape of the SSC profile
to use. The available selections are:
Sine, Triangle, and Custom (see
page 96).

Triangle

Spread Select the SSC spread to use. The
available selections are: Up, Down,
Center, and Unequal.

Down
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Table 28: Setting SSC parameters (cont.)

Option Description Range, Default value

Unequal Spread Enter the unequal spread. 0% to 100%, except 50 indicates
unequal spread.

0 is equivalent to Down spread.

50 is equivalent to Center (equal)
spread.

100 is equivalent to Up spread.

Default: 0%

df/dt

Minimum Duration Enter the minimum duration of df/dt.
The duration is the same for both the
rising and falling edges.

0 µs to 5 µs, 0 µs

Location Enter the location of df/dt. This
specifies the location (in % of height)
of the df/dt spike on both the edges.
The spikes are located symmetrically
on both the rising and falling edges.

20 % to 80 %, 50 %

df/dt Enter the df/dt of the waveform. This
defines the sudden deviation (spikes)
of the SSC profile from the predefined
pattern.

0 ppm/µs to 5000 ppm/µs, 0 ppm/µs

Frequency

Deviation (Hz) Enter the frequency deviation. This
defines the maximum deviation of the
data rate from mean data.

0 ppm to 200000 ppm, 4000 ppm

Modulation Enter the frequency modulation.
This defines the frequency of the
modulating SSC profile.

10 kHz to 500 kHz, 33 kHz

xxx
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4. SerialXpress supports adding noise and peak controlled pre/de-emphasis. Select and enter the
following:

Table 29: Noise and Pre-Emphasis options and their description

Option Description Range, Default

Noise Enter the amplitude of the noise (in
volts) to generate.

0 Volt (RMS) to 0.5 Volt (RMS),
0 Volt (RMS)

Add Noise At Select where the random noise will
be added to the waveform. It can be
added to simulate the near end or far
end.

Near end and Far end, Near end

Noise Frequency Select the type of noise either, Full
Bandwidth or Single Tone noise.

Full Bandwidth: Generates white
noise between 0 Hz to Fs/2 Hz.

Single Tone: Generates sine
noise at the specified frequency.

For an example, see Generate
Common Mode Noise (see page 107)

10 Hz to Fs/2 Hz

Pre/De-emphasis and Preshoot Enter the amplitude (in dB or volts) of
the pre/de-emphasis and preshoot to
be introduced in the waveform.

0 dB to 20 dB, 0 dB

Advanced Setup (see page 35) Select this to apply the advanced
pre/de-emphasis and/or preshoot
parameter settings. Click this button
to open the Advanced Settings dialog
box.

For more details on pre/de-emphasis
and preshoot, refer to
Pre/De-emphasis (see page 100).

Disabled

xxx
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Setting ISI and S-Parameter Filter Parameters

Click Channel/Cable tab to specify inter-symbol interference (ISI) or S-Parameter Filter parameters
for the waveform.

1. To specify the ISI, select the ISI option.

2. To specify the S-Parameter filter, select the S-Parameter Filter option.

3. Set the following channel/cable parameters:

Table 30: Channel/Cable options and their description

Option Description Range, Default

ISI Select this option and specify the
inter-symbol interference (in UI or
seconds).

0 UI to 1 UI, 0 UI

S-Parameter Filter

Select the Mode Select the S-Parameter filter mode
(see page 62). The available
selections are: Non-Cascading and
Cascading.

Non-Cascading

Plot frequency response on compile Select this to plot the frequency
response of the S-parameter file.

This will display two plots showing:

Frequency characteristics of the
S-parameter file

Frequency response of the
computed filter

Disabled

Bandwidth limit – embed/de-embed Select the bandwidth limit –
embed/de-embed. The available
selections are: None, Auto, and
Custom.

A bandwidth limit filter is applied to
the response of the Touchstone file to
limit the bandwidth of the filter. The
cutoff frequency of this bandwidth limit
filter is calculated depending on the
selection.

If you select None, the cutoff
frequency of the filter is Fs/2 (where
Fs is the sampling frequency).

If you select Auto, the cutoff frequency
is the –14 dB point of the channel
response.

If you select Custom, the cutoff
frequency is the frequency that you
specify.

None
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Table 30: Channel/Cable options and their description (cont.)

Option Description Range, Default

Read from File Browse and select the file from which
to read the filter.

The files supported are s1p, s2p,
s4p, and s8p.

s4p

Inverse Filter

Write to File Browse and select the inverse filter
(see page 62) file.

Disabled

Sampling Frequency Specify the sampling rate for the filter
file.

25 GHz or 50 GHz, 25 GHz

ISI Scaling (see page 98) Enter the ISI scaling. 0 to 10, 1

xxx

Inverse Filter

Inverse filter is used to neutralize the effect of the cable and produce an undistorted waveform.

To get an undistorted waveform, select the corresponding S-Parameter file of the cable in use using Read
From File. Inverse filter is applied to the generated waveform and passed through the cable to the DUT.
An undistorted Eye DPO waveform is produced at the DUT.

S-Parameter Cascading

S-parameter cascading is used to emulate the effect of multiple components in a Serial Data test system.
This could be multiple channels connected one after the other as in USB 3.0 or different components like
connectors, channels, and fixtures connected together as in a typical high speed serial data test system.

S-parameter cascading is accomplished by first converting individual S-parameter data to T-Parameter,
then combining all T-parameters to obtain residual T-parameter. This residual T-parameter is again
converted to S-parameter.

S-Parameter Filter Mode

You can either select Non-cascading or Cascading S-parameter mode.

In the non-cascading mode, you can apply S-parameter characteristics on the signal from only one
S-parameter file. From the Read From File field, browse and select the Touchstone file. The files
supported are s1p, s2p, s4p, and s8p.

In the cascading mode, you can cascade up to six S-parameter files and apply the characteristics on the
signal. You can select the files to apply by turning on or turning off the corresponding blocks shown in
the display. All the selected files should be of the same type. The settings depend on the selected type
of file (*.s1p , *.s2p *.s4p, and *.s8p). The type (single-ended or differential) and port selection are
common for all the cascading files. You can select the files by clicking inside the boxes and browsing to
the file. Click On/Off to include or exclude the file.
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S-Parameter Touchstone Files

The S-parameter (Touchstone) file can contain data for 1-port, 2-port, 4-port, or 8-port devices. Once a file
is selected, the application reads its contents and displays the appropriate controls for you to select the
particular S-parameter in the file to use.

One-port. Files with one port of data contain only one S-parameter file (s1p) so they do not require
any further input.

Two-port. Files with data for two ports contain four S-parameters as a 2x2 matrix. These are Touchstone
2-port files (s2p). When the application recognizes such an S-parameter file, a dialog box is created for
you to select the S-parameter representing channel transmission. By default, SerialXpress assumes the
location of the channel transmission data in the file to be S21.

Four-Port. Files with data for four ports may contain single-ended or differential data. These are
Touchstone 4-port files (s4p). By default, SerialXpress assumes the file to be Differential data type.

If the data is single-ended, you must map the port numbers as used in the file to physical locations
in your link. A default mapping is assumed. The application will use this mapping to compute the
Sdd21 parameter (for transmission of a differential signal) from the appropriate four S-parameters
measured using single-ended data.

You can select the port for both transmitter and receiver from the drop-down list. Each drop-down
list has ports from 1 to 4. The default port number is as follows:

Type Default port

Tx+ 1

Tx– 3

Rx+ 2

Rx– 4

xxx

If the data is differential, you must select the data layout in the file. By default, SerialXpress assumes
the file to use Typical port layout format. The application always uses the Sdd21 parameter for
computing the transmitted waveform no matter which mapping is selected.

Eight-Port. These are Touchstone 8-port files (s8p). SerialXpress supports s8p files in both cascading
and non-cascading modes. By default, SerialXpress assumes the file to be Differential data type. Browse
and select a Touchstone file and do the following:

SerialXpress User Manual 63



Creating a Signal Setting ISI and S-Parameter Filter Parameters

Table 31: Aggressor options and their description

Option Description Default

Aggressor Select this to activate aggressor signal
parameters and to add the effect of
cross-talk.

Enabled

Signal Select the signal to use. The available
options are:

Pattern file: Indicates that the
aggressor signal is another pattern
file.

Clock: Indicates that the
aggressor signal is a clock pattern.

Same as victim: Indicates that
the aggressor signal is same as
the victim signal and has all the
characteristics of the victim signal.

Pattern file

Pattern Browse and select the pattern file. –

Data rate Specify the data rate (in bps) of the
signal.

This option is available only when the
Aggressor signal is set to Pattern file.

The data rate set in the Base pattern
tab.

Amplitude Scale Enter the scale of the signal. 1

Rise/Fall Enter the rise and fall times (in s or
UI) of the signal.

For the aggressor signal, the
maximum value of the rise and
fall times varies depending on the
aggressor data rate.

The rise time set in the Base pattern
tab.

Frequency Enter the frequency (in Hz) of the
clock signal.

This option is available only when the
Aggressor signal is set to Clock.

Equal to the data rate set in the Base
pattern tab.

Direction Select the direction of the signal. The
available options are:

Same as victim: Indicates that
the signal flow of the aggressor is
same as the victim.

Opposite to victim: Indicates that
the signal flow of the aggressor is
opposite to the victim.

Same as victim

xxx

Touchstone 8–port Data Type. When you select single-ended, you can select the port for both transmitter
and receiver from the drop-down list. Each drop-down list has ports from 1 to 8. The default port numbers
of the victim and aggressor signals are as follows:
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Victim signal

Type Default port

Tx+ 1

Tx– 2

Rx+ 5

Rx– 6

Aggressor signal

Type Default port

Tx+ 3

Tx– 4

Rx+ 7

Rx– 8

xxx

NOTE. All the port numbers should be unique.

If you select Differential port type, pair 1 is the victim signal (by default) and pair 2 is the aggressor signal.
By selecting Swap port definitions, pair 1 is the aggressor signal and pair 2 is the victim signal.
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Connecting to an instrument

SerialXpress can be connected to various networked instrument types through either LAN or GPIB
networks.

The Instrument Control dialog screen provides tabs for these instrument types:

AWG – Tektronix Arbitrary Waveform Generators including AWG70000A Series, AWG7000 Series,
and AWG5000 Series.

Oscilloscopes – Tektronix oscilloscopes

The connection is made via the TekVISA communication software. TekVISA must be installed and
running on both the PC (with SerialXpress) and the target instrument. Use the Open Choice Resource
Manager tool in TekVISA (on the PC with SerialXpress) to discover the networked instruments.

NOTE. For AWG5000 and AWG7000 Series Arbitrary Waveform Generators, it’s recommended to install
SerialXpress directly on the instrument. SerialXpress automatically detects the generator and appears in
the AWG tab of the Instrument Control dialog screen.

Once TekVISA has located your instruments, use the Find Instruments in the Instrument Control dialog
box to select and connect to the instrument.

1. Click Find Instruments. The following dialog box opens.
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The table lists the instruments found with the name of the instrument, model, status (connected or
not), and the connection type (Ethernet or GPIB).

2. Select an instrument from the table. Use the following buttons.

Table 32: Find instruments options

Button Description

Connect Allows you to Connect to the instrument selected in the table. Enabled is default if an instrument is
highlighted in the table; disabled if no instrument is highlighted.

Disconnect Allows you to Disconnect the connected instrument. Enabled only when an instrument is connected.

Refresh Refreshes the list of instruments.

Import... (see
page 33)

Opens the Import from Tektronix Oscilloscope dialog box.

xxx

3. Click Connect to connect to the selected instrument.

NOTE. If you cannot find your AWG70000A series instrument after installing TekVISA, check to see if NI
VISA is installed on your PC.

If NI VISA has been installed, see the procedure below to repair the installation.

Connection problem to an AWG70000A series instrument

If you cannot find your AWG70000A series instrument after installing TekVISA, it could be due to a
previous installation of NI VISA.

If NI VISA has been installed, you need to replace the Visa32.dll file, use the following steps:

On a Windows 7, 64 bit, PC.

1. Locate and copy the Visa32.dll file. This file can be found in one of two places:

C:\Program Files(x86)\IVI Foundation\VISA\WinNT\TEkVISA\Bin

C:\VXIpnp\WINNT\TekVISA\Bin

2. Navigate to C:\Windows\SysWOW64

3. Paste the Visa32.dll file, replacing the existing file.
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On a Windows 7, 32 bit, PC.

1. Locate and copy the Visa32.dll file. This file can be found in one of two places:

C:\Program Files\IVI Foundation\VISA\WinNT\TEkVISA\Bin

C:\VXIpnp\WINNT\TekVISA\Bin

2. Navigate to C:\Windows\System32

3. Paste the Visa32.dll file, replacing the existing file.

Controlling an AWG70000A Series Arbitrary Waveform Generator

NOTE. To establish a connection to an AWG70000A Series generator, you must run the AWG70000A
Series configuration utility located in the Tektronix SerialXpress Program folder. See AWG70000 Series
configuration utility (see page 4.).

After establishing a connection with an AWG70000A Series arbitrary waveform generator (using the Find
Instrument in the Instrument Control dialog screen), use the AWG tab in the Instrument Control screen
to see the connected AWG.

The Setting displayed are the settings read by SerialXpress. Use the Refresh Setting button to update
the display.

SerialXpress does not provide direct access to the controls of an AWG70000A Series arbitrary waveform
generator. But once connected to it via a LAN connection, you can compile and send waveforms to the
instrument.

When compiling and sending a waveform, SerialXpress adjusts the controls of the instrument to
appropriate settings for the compiled waveform.

Settings affected are:

Playout temporarily stopped during setup

Channels enabled

Channel amplitude set

Run Mode set to Continuous
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Clock Source set to Internal

Sample rate adjusted

Reduce Jitter function turned off

Playout enabled

Any further control settings or stopping and starting playout must be done from the instrument.

NOTE. If you have not run the AWG70000A Series configuration utility to provide SerialXpress with the
type of AWG70000A Series generator you are attempting to connect with, an error message is displayed.
See AWG70000 Series configuration utility (see page 4.).

Controlling an AWG5000 or AWG7000 Series Arbitrary Waveform
Generator

SerialXpress interfaces with an AWG5000 or AWG7000 series insttument in the following ways:

Installing SerialXpress on an AWG series instrument can directly send and receive data from the AWG.

Installing an offline version of SerialXpress on a PC with an offline version of the AWG software can
detect the presence of the AWG software and send data to it. This data can be opened and viewed
in the AWG software.

You can control the following AWG parameters:

Channel waveform

Amplitude

Sampling rate

Interleave (Option 06 only)

Interleave Zeroing (Option 06 only)

SerialXpress supports the following operations:

Transferring a waveform data to AWG as real format waveform. During this operation, the marker
data is also transferred.

Loading a waveform to a channel.

Changing the run state.

Do the following steps to control and transfer a waveform to an AWG:

1. SelectWindow > Instrument Control.

2. From the AWG tab, you can modify the values of the following AWG parameters:
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Table 33: AWG parameters and their description

Selection Description Default value

Sampling Rate Displays the sampling rate of the
AWG.

The default is as set in the AWG.

Interleave (see page 92) Sets the interleave option to On or Off. Off

Zeroing (see page 94) Enabled only when Interleave is set
to On.

Disabled

Ch 1 Select this to receive the output from
channel 1.

This depends on the channel present
on the AWG.

Ch 2 Select this to receive the output from
channel 2.

This depends on the channel present
on the AWG.

Amplitude (Vpp) Displays the amplitude of the selected
channel. Change the amplitude in this
field to change the amplitude on the
channel.

The default is as set in the AWG.

Waveform Displays the selected waveform
name. You can drag and drop the
waveform from the Waveform List.
When you drag and drop a waveform,
the sampling rate is automatically set.

N/A

xxx

The following button is available:

Table 34: AWG options

Button Description

Advanced Opens a dialog box where you can set the advanced AWG
control options.

xxx
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3. When you click Advanced, the following options are available for each channel:

Table 35: Advanced AWG parameters

Selection Description

DAC Resolution

DAC Resolution Displays the channel DAC resolution that is set in the AWG.

Markers (M1 and M2)

High (V) Enter the high value for the markers.

Low (V) Enter the low value for the markers.

Delay (s) Enter the maker delay.

xxx

NOTE. When connected to an AWG5000 series instruments, the DAC resolution is fixed to 14 bits and
cannot be changed.
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Connecting to and Controlling an Oscilloscope

SerialXpress can be used to control a connected Tektronix oscilloscope, acquire oscilloscope waveforms
into SerialXpress, and transfer it to an AWG.

Follow these steps to find oscilloscopes connected to the AWG on which SerialXpress is running:

1. SelectWindow > Instrument Control.

2. A table lists the connected oscilloscopes. From the Oscilloscope tab, you can modify the values of the
following oscilloscope parameters:

NOTE. Ensure that the Sampling mode on the oscilloscope is set to Real Time. If the Sampling mode is
set to Interpolation (either automatically or manually), the parameter values in SerialXpress Instrument
control and the oscilloscope may not match.

3. Click Find Instruments. The following dialog box opens.

The table lists the oscilloscopes found along with the name of the model, status (connected or not), and
the connection type (Ethernet or GPIB).
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4. Select an oscilloscope from the table. Use the following buttons to:

Table 36: Find instruments options and their description

Button Description

Connect Allows you to connect to the selected oscilloscope in the
table. Enabled by default if an oscilloscope is highlighted in
the table; disabled if no oscilloscope is highlighted.

Disconnect Allows you to disconnect the connected oscilloscope.
Enabled only when an oscilloscope is connected.

Refresh Refreshes the list of oscilloscopes.

Import (see page 33) Opens the Import from Tektronix Oscilloscope dialog
box.

xxx

5. Click Connect to connect to the selected oscilloscope.

Table 37: Oscilloscope parameters

Selection Description

Vertical Settings

Channel Displays the channel to which the scale can be set. To
change this setting, select another channel.

Scale (V) Displays the vertical scale set in the oscilloscope for the
selected channel. Change the value in this field to change
the vertical scale on the connected instrument.

Horizontal Settings

Scale (s) Displays the horizontal scale set in the oscilloscope.
Change the value in this field to change the horizontal scale
on the connected instrument.

Record Length Displays the record length set in the oscilloscope. Change
the value in this field to change the record length on the
connected instrument.

Sampling Rate (S/s) Displays the sampling rate set in the oscilloscope. Change
the value in this field to change the sampling rate on the
connected instrument.

Acquisition

Run Starts the acquisition of data on the oscilloscope.

Stop Stops the acquisition of data on the oscilloscope.

Single Sets the oscilloscope to acquire one full record length and
then stops.

xxx
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The following buttons are available in this tab:

Table 38: Oscilloscope options

Button Description

AutoSet Performs autoset on the oscilloscope.

Refresh Settings Refreshes the display with the current instrument settings.

Refresh List Refreshes the connection status of the instruments.

Find Instruments Finds instruments on the network.

xxx
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Zooming Graphs

You can zoom in or zoom out on a graph. ClickMaximize to display the graph in a large window. You can
zoom in on a plot by selecting an area of interest. SerialXpress supports the following graphs:

Rise/Fall (see page 78)

Simulated Data Signal (see page 79)

Random Jitter (see page 80)

Periodic Jitter (see page 81)

Total Jitter (see page 82)

Normal Eye (see page 83)

Eye DPO (see page 84)

TIE (see page 85)

You cannot save the graphs. You can only save the graphs by doing a screen capture. You must regenerate
a graph using Compile every time you change parameter values. The existing graphs are not automatically
updated.

For more details, refer to Graph Setup (see page 23).
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Rise/Fall

The rise/fall graph shows the plot of Time (Samples) (X-axis) and Amplitude (Volts) (Y-axis).
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Simulated Data Signal

The simulated data waveform graph shows the plot of Time (Samples) (X-axis) and Amplitude (Volts)
(Y-axis).
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Random Jitter

The random jitter graph shows the plot of Tie Error (ps) (X-axis) and Frequency of Occurrence (Y-axis).
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Periodic Jitter

The periodic jitter graph shows the plot of Tie Error (ps) (X-axis) and Frequency of Occurrence (Y-axis).
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Total Jitter

The total jitter graph shows the plot of Tie Error (ps) (X-axis) and Frequency of Occurrence (Y-axis).
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Normal Eye

The normal eye graph shows the plot of Time (UI) (X-axis) and Amplitude (Volts) (Y-axis).
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Eye DPO

The eye DPO graph shows the plot of Time (UI) (X-axis) and Amplitude (Volts) (Y-axis).

The following table shows the summary of the various jitter parameters used to create the waveform:

In the Eye DPO plot, all the jitter parameters that are set in the application are shown in a table.

The total jitter is calculated using the formula Tj = ( 14 * Rj ) + Dj where,

Tj is the Total Jitter at a specified Bit Error Rate (TJ@BER). This extrapolated value predicts a
peak-to-peak jitter that will only be exceeded with a probability equal to the BER (TJ (1E-12)).

Rj is the RMS value of total Random Jitter. , where Rj1, Rj2, and Rj3 are RMS
values of three independent, band limited, zero mean, and Gaussian distributed jitters.
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Dj is the Deterministic Jitter, which is the sum of Periodic Jitter (Pj), Inter Symbol Interference (ISI), and
Duty Cycle Distortion (DCD).

TIE

The TIE graph shows the plot of Frequency (Hz) (X-axis) and Jitter (Secs) (Y-axis). This plot shows
the raw Fast Fourier Transform (FFT) of the TIE.
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Error Messages

The following table lists the error codes for the application.

Table 39: Error messages for SerialXpress

Error message Description Solution

Not ready. SerialXpress application is not ready. Start SerialXpress.

SerialXpress instance is already
running.

Second instance of SerialXpress is
started.

Check task manager if the
SerialXpress application is already
running. If the application is
running, stop that process and start
SerialXpress again.

Trial period has expired.

You cannot transfer and save the
waveform.

The total number of trials of 10 is
exceeded.

Enable the function (to transfer or
save the waveform) with an option
(license) key.

Invalid file name. File name is not according to
SerialXpress requirements.

Apply Microsoft Windows file naming
conventions.

File does not exist. The specified file name does not exist. Ensure that the file path and name are
correct.

Directory does not exist. The specified directory is incorrect. Browse the correct directory instead
of entering the path.

Unable to compile waveform. The application fails to create the
waveform.

Ensure that the base data size does
not exceed 2.5 MB.

DTG file import failed. Either the file is corrupt or DTG file
format is incorrect.

Ensure that the DTG file format is
correct and that the file is not corrupt.

Waveform name cannot be empty. The waveform name is not specified. Specify a waveform name that does
not exceed 32 characters.

No selected waveform to save. No waveform has been selected to
save.

Select a waveform to save.

Waveform name specified already
exists.

The same waveform name is
specified.

Do one of the following:

Ensure that the waveform name
is different.

Ensure that the Overwrite
option is enabled in the Compile
Settings dialog box.

Symbol is not valid The symbol entered is invalid and its
binary code is not defined.

Reenter a valid symbol. For valid
symbol values, refer to the Setting the
Base Pattern section. (Selecting a
User Pattern )

Batch setup settings error. The Start value of either Random
Jitter or Periodic jitter is greater than
the End value.

Ensure that the Start value is less
than the End value in the Batch
Compile Setup dialog box.
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Table 39: Error messages for SerialXpress (cont.)

Error message Description Solution

Both random jitter and periodic jitter
are disabled. Batch compilation will
generate a single waveform without
any jitter.

The Batch Compile Setup dialog box
has both Random and Periodic Jitter
disabled.

Ensure that one or both Random and
Periodic Jitters are enabled.

Error on parsing PRBS polynomial. The PRBS polynomial syntax is
incorrect.

Enter the correct PRBS polynomial.

Failed to read data or invalid format. File format is incorrect. Apply valid file format.

AWG is not available. The Advanced option in Instrument
Control tab has been clicked without
starting the AWG application.

Ensure that AWG application is started
before starting SerialXpress.

Unauthorized access permission. Permission not available to read a file. Ensure that the file has read
permission.

Polynomial length exceeds the
maximum.

The order of the polynomial is greater
than the specified value.

Ensure that the order of the polynomial
is less than or equal to 18.

Unable to read or Invalid SSC custom
profile file.

Either the SSC custom profile file is
corrupt or file format is incorrect.

Do one of the following:

Ensure that the file is not corrupt.

Ensure that the custom SSC
profile is according to the format
specified. Custom SSC (see
page 96)

No transition exists. Either the input base pattern has all
zeroes or all ones, or the encoding
scheme is set to NRZ.

Do one of the following:

Enter patterns with a combination
of zeroes and ones.

Ensure that the encoding scheme
is set to 8B10B.

Setting waveform to the channel
failed.

The application failed to load the
waveform to the AWG channel.

Do one of the following:

Ensure that the waveform exists
in the AWG waveform list.

Ensure that the waveform size
does not exceed the AWG memory
limit.

Ensure that the channel name is
valid.

Failed to set the sampling rate on the
AWG.

The application failed to set the
sampling rate on the AWG.

Do one of the following:

Ensure that the sampling rate is
within the AWG limits.

Ensure that the Clock is set to
Internal and the Reference is
set to either Internal or External
(fixed).
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Table 39: Error messages for SerialXpress (cont.)

Error message Description Solution

Failed to set the output to ON for
channel.

The application failed to turn the
channel state to ON on the AWG.

Ensure that the channel name is valid
and has a waveform loaded into it.

Failed to set the run state to ON on
the AWG.

The application failed to set the run
state to ON on the AWG.

Ensure that the waveforms are
loaded to the AWG channels and
the application is not waiting for an
external trigger.

No TouchStone file selected. The application does not have a
Touchstone file selected in the screen
display or remote command during
compilation.

Ensure that a valid Touchstone file is
selected in S-Parameter Filter screen
display or remote command before
compiling.

The physical port assigned for
single-ended Touchstone file is
incorrect.

Same port is selected for both
transmitter and receiver.

Ensure that a unique port is selected
for each of the physical location.

Polynomial is invalid. The length of the polynomial
expression cannot be zero or greater
than 256.

Enter a valid polynomial expression.

Invalid polynomial. The polynomial expression is
incorrect. This happens if:

The polynomial is incomplete.

The degree of the polynomial is
greater than 32 or less than one.

The polynomial expression
contains a negative sign.

Ensure that the polynomial format is
correct.

Repeat count is out of range. The value has to be an integer from
1 to 1 M.

Enter a valid repeat count value.

Invalid data for Repeat count. The value in the Repeat count column
is invalid. The value has to be either
an integer value from 1 to 1 M or
“Infinite”.

Enter a valid repeat count value or
Infinite.

Go To index should be different from
the selected index.

The value specified in the Go To
column cannot be same as the
selected sequence index.

Specify a valid sequence element
index.

Go To index is out of range. The value specified in the Go To
column is invalid and is not within the
sequence range.

Specify a valid sequence element
index.
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Table 39: Error messages for SerialXpress (cont.)

Error message Description Solution

Total memory occupied by all the
sequence waveforms is more than the
AWG memory.

The memory occupied by the
sequence waveforms exceeds
the maximum AWG memory and
compilation stops.

Do one of the following to proceed
with compilation:

Delete unwanted waveforms in
the AWG.

Reduce the sequence length in
the application.

Reduce the waveform
parameters.

No aggressor selected for s8p. Aggressor pattern file is not selected
when aggressor signal is a Pattern file.

Select a pattern file before compilation.

Error in cascading s8p file. The selected files have different
data types which result in all zero
co-efficients.

Select the same data type in the
application as that of the S-Parameter
file selected (Single-ended or
Differential).

The S-parameter file of sequence
index (n) is different from the other
sequence element.

Each sequence element is of a
different type.

Select the same S-parameter file type
for all the files (s1p, s2p, s4p, or s8p).

Too many pattern files to add. Cannot
exceed maximum sequence definition
of 1000.

The number of sequence elements
added exceeds 1000.

Reduce the sequence elements in the
application.

Invalid data format in S-parameter file. Either an invalid S-parameter file
is selected or the data type in the
Touchstone file is different from the
one selected in the application.

Do one of the following:

Select a valid S-parameter file.

Select the same data type
(Single-ended or Differential).

The number of waveforms than can
be generated by batch compile cannot
exceed 500.

The number of waveforms added
exceeds 500 in batch compile.

Do one of the following:

Reduce the magnitude of the
random and periodic jitters.

Increase the increment of the
random and periodic jitters.

Batch compile cannot be applied to
idle state elements.

Idle state elements cannot be batch
compiled.

Disable batch compile for the idle
state elements.

Insufficient SPUI for PWM waveform
generation.

The minimum SPUI value required is
4 to generate a PWM waveform. For
best results use 6 SPUI or more.

Enter a valid SPUI value.

Invalid combination of parameters:
Use either PWM or 4-PAM but not
both.

Both PWM and 4-PAM encoding
cannot be selected.

Select either PWM or 4-PAM encoding
to generate a waveform.

Invalid combination of parameters:
The number of input bits should be
even.

While using 4-PAM encoding, the
length of the input pattern must be an
even number.

Enter a valid input pattern.
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Table 39: Error messages for SerialXpress (cont.)

Error message Description Solution

Invalid data format in S-parameter file.
The coefficients are all zeros.

The forward transmission co-efficients
in the file are all zeros. This channel
cannot be emulated.

Enter a valid input data.

Waveform Generation Failed. Try with
reduced jitter parameters.

This error message is caused by
conflicting requirements of various
jitter parameters.

Try reducing one of the dialed jitter
parameters, such as Random Jitter
(Rj), Periodic Jitter(Pj), and SSC

xxx

Shortcut Keys
Table 40: Shortcut keys

Menu/Menu item Shortcut key

File Alt+F

File > Open Setup Ctrl+O

File > Save Setup Ctrl+S

File > Restore Default Setup Ctrl+N

View Alt+V

Configure Alt+C

Waveform Alt+W

System Alt+S

Window Alt+I

Help Alt+H

xxx

PRBS Editor Starting Values

The following table gives the initial shift register values and the PRBS polynomial expression:

Table 41: Initial shift values and PRBS polynomial expressions

PRBS Shift register initial value PRBS polynomial expression

PRBS 7 1 1 1 1 1 1 1 X7+X6+1=0

PRBS 9 1 1 1 1 1 1 1 1 1 X9+X5+1=0

PRBS 15 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 X15 +x14+1=0

PRBS 16 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 X16+X14+X13+X11+1=0

xxx
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AWG Specifications

For information on the specifications of the AWG5000 and AWG7000 series instruments, refer to the
following documents:

AWG70000 Series Arbitrary Waveform Generators Specifications and Performance Verification
Technical Reference, Tektronix part number 077-0780-xx.

AWG5000 Series Arbitrary Waveform Generators Specifications and Performance Verification
Technical Reference, Tektronix part number 071-2082-xx.

AWG5000B Series Arbitrary Waveform Generators Specifications and Performance Verification
Technical Reference, Tektronix part number 071-2486-xx.

AWG5000C Series Arbitrary Waveform Generators Specifications and Performance Verification
Technical Reference, Tektronix part number 077-0455-xx.

AWG7000 Series Arbitrary Waveform Generators Specifications and Performance Verification
Technical Reference, Tektronix part number 071-1853-xx.

AWG7000B Series Arbitrary Waveform Generators Specifications and Performance Verification
Technical Reference, Tektronix part number 071-2487-xx.

AWG7000C Series Arbitrary Waveform Generators Specifications and Performance Verification
Technical Reference, Tektronix part number 077-0456-xx.

You can view the document by selecting Start > All Programs > Tektronix > AWG > Documentation.

Interleave (AWG7000 Series only)

The AWG7000 with Option 06 supports the interleaving mode. The following table shows the amplitude
and sampling rates for the interleaving and non-interleaving modes.

Table 42: Amplitude and sampling rates in non-Interleave and interleave modes

Non-Interleaving Interleaving

Amplitude (min, max) Sampling rate (min, max) Amplitude (min, max) Sampling rate (min, max)

500 mVpp, 1 Vpp 10 MS/s, 10 GS/s (for
AWG7102)

10 MS/s, 12 GS/s
(for AWG7122B and
AWG7122C)

10 MS/s, 8 GS/s (for
AWG7082C)

500 mVpp, 1 Vpp 10 GS/s, 20 GS/s (for
AWG7102)

12 GS/s, 24 GS/s
(for AWG7122B and
AWG7122C)

8 GS/s, 16 GS/s (for
AWG7082C)

xxx

In the Interleaving mode, the output is available in a separate interleave connector as shown in the figure.
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As an example, in the non-interleave mode let the sampling rate be 20 GS/s and the original amplitude
samples be 0.1, 0.2, 0.3, 0.4, 0.5, 0.1, 0.2. This can be represented graphically as shown here.

In the interleave mode, alternate samples are output from each channel. That is, the samples are distributed
between the two channels as shown:

Ch1 Ch2

0.1 0.2

0.3 0.4

0.5 0.1

0.2 0

xxx
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This can be represented graphically as shown.

Zeroing

When Interleave is on, you can turn Zeroing on or off to enhance the available bandwidth. This function
is available only when Interleave is available. If you compose waveform data that is divided into two
channels, the zeroing function allows you to select whether you want to handle each waveform as RZ
(Return to Zero) or NRZ (Non Return to Zero).

If you turn the zeroing function on, the bandwidth increases. However, spurious characteristics will worsen
(increase in the frequency spectra that should not be output) and the amplitude range will be halved.
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Parameter Definitions

Definitions of the jitter and time related parameters are given in the following table:

Table 43: Jitter/Time parameters and their description

Parameters Description

Jitter

RJ Random Jitter is jitter that does not exhibit deterministic
behavior and is not bounded. It can be described by a
Gaussian probability distribution. It is characterized by
standard deviation value (RMS).

PJ Periodic Jitter is the portion of the deterministic jitter that
is periodic, but for which the period is not correlated with
any data in the waveform. It is measured by peak-to-peak
variation and frequency.

DCD Duty Cycle Distortion is the portion of the deterministic jitter
directly correlated with waveform polarity (the difference in
the positive edges and negative edges).

Noise This is a type of additive nois (see page 106) that modifies
the vertical amplitude of the serial data and contributes to
the jitter.

Time

Rise Time Elapsed time between the low reference level crossing and
the high reference level crossing on the rising edge of the
waveform. It is measured in time units between the 10%
and 90% levels or between the 20% and 80% levels.

Fall Time Elapsed time between the high reference level crossing and
the low reference level crossing on the falling edge of the
waveform. It is measured in time units between the 10%
and 90% levels or between the 20% and 80% levels.

xxx

About Calibration

SerialXpress creates pre-distorted waveforms with precise amount of distortion. The types of distortion
can include random jitter, ISI, and others. The AWG generates these waveforms from the SerialXpress
and transmits them to the DUT through a cable. These generated waveforms are measured on the
oscilloscope. If the resulting waveform is not as expected, it could be due to distortion caused by either
inherent jitter within the AWG or the characteristics of the transmitting cable. Calibration minimizes the
errors in random jitter.

Calibration is performed on a specific AWG, oscilloscope, and associated cable and fixtures with a defined
sampling rate and data rate. Changes in any of these requires recalibration.

Error is the deviation between the expected result and the actual result.
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The calibration data is saved as sxc file.

sxc is a custom format binary file which includes correction information on Rj and Pj.

About Spread Spectrum Clocking (SSC)

Spread Spectrum Clocking (SSC) is the technique of modulating the clock frequency to minimize electro
magnetic induction (EMI) effects. SSC is generated with a profile having a frequency and frequency
deviation. The frequency deviation is specified in ppm. The available SSC profiles are sinusoidal,
triangle, and custom.

NOTE. To generate integer cycles of the SSC profile, the software may alter the frequency of the SSC to
meet the memory requirements of the instrument.

Custom SSC

The custom SSC profile is a comma separated file with the extension csv.

The format of the custom SSC is as follows:

<time>,<ppm><cr><lf>

<time>,<ppm><cr><lf>

........................................

........................................

The first column represents time and the second column represents deviation in ppm.

where,

<cr> refers to carriage return.

<lf> refers to line feed.
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About Wrap Between Sequence Elements

When a set of jitter waveforms is sent to the AWG sequence, there might be discontinuity in the periodic
jitter time domain (TIE plot) or in the encoding disparity between two successive waveforms.

Wrap between sequence elements ensures the continuity of the waveform sample when the sequence
execution moves from one sequence element to another. The application may generate multiple waveforms
in the AWG corresponding to a single pattern in SerialXpress.

The following examples show waveforms with and without Wrap between sequence elements.

TIE plot with PJ jitter without wrap between sequence elements

TIE plot with PJ jitter with wrap between sequence elements

Waveform plot without wrap between sequence elements
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Waveform plot with wrap between sequence elements

About Inter Symbol Interference (ISI)/ISI Scaling

Inter Symbol Interference (ISI) is generated due to the limited bandwidth of the channel. The following
are the two ways to generate ISI:

Method 1: Using digital filter to simulate the effect of ISI by directly entering the ISI value in the
Channel/Cable tab

When ISI is 0, no ISI is introduced through the filter. However, the signal will contain some ISI depending
on various parameters like bit pattern, rise/fall time, data rate, connecting cables, and so on.

When the value of ISI is increased, the measured ISI increases. The following indicative chart can be
used to get the required ISI:
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Method 2: Using S-Parameter filter and ISI scaling

The S-Parameter files contains the values of the specific devices used to connect the DUT. When you
select an S-Parameter file, the corresponding values of the device are applied to the waveform causing
distortion. If you use the cable of the corresponding S-Parameter file instead of the S-Parameter file, the
same output is obtained at the DUT.

NOTE. ISI scaling is enabled only when you select S-Parameter Filter.

When ISI scaling is 0, the effect of ISI is not seen and the waveform is undistorted.

When ISI scaling is in the range 0–1, the effect of ISI gradually increases. At 1, the effect of ISI is
completely introduced thereby causing a distorted waveform.

When ISI scaling is in the range 1–10, the effect of ISI will further increase.
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You can see the effect of ISI in the Eye DPO plot and the Data Dependent Jitter (DDJ) can be measured on
the oscilloscope. As the data rate and the sampling rate increase, the effect of ISI increases.

About Pre/De-Emphasis

You can apply the following pre/de-emphasis and preshoot to a waveform:

Pre/De-emphasis only

Preshoot only

Pre/De-emphasis and Preshoot

The following three types are available for pre/de-emphasis and preshoot:

UI-Constant – A constant value is applied to all the samples in the UI. The following shows an
example of UI-Constant:

UI-Linear – Linearly increasing values are applied to all the samples in the UI. The following shows
an example of UI-Linear:

Fractional – The allows you to specify a value for every sample in the UI. The following shows an
example of Fractional:
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Multi-tap Pre/De-emphasis. You can control signal value of more than one UI. The maximum number of
taps that can be specified is 5. The following shows an example of multi-tap pre/de-emphasis:

The following equations are used to convert dB to Volt and Volt to dB:

V = 10 ^ (dB/20) – 1

dB = 20 * log10(1 + V)
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About Pulse Amplitude Modulation (PAM)

The 4-PAM symbols are represented as [0 1 2 3]. The symbol size 'M' is equal to four, which means that
four amplitude levels are assigned to each of these symbols.

Example. The peak-to-peak voltage of the signal is 1 V (–0.5 V to +0.5 V).

The four amplitude levels representing [0 1 2 3] of the PAM symbols are [–0.5000 V –0.1667 V 0.1667 V
0.5000 V].

You can assign input data only in Binary format to the 4-PAM symbols.

If the user pattern is 00011011100100, then 4-PAM sequence would be 0 1 2 3 2 1 0, where 2-bits form an
4-PAM symbol. The generated waveform is as shown below:

NOTE. The length of the input pattern must be an even number to form a 4-PAM symbol. Pre/De-emphasis
is not applicable for 4-PAM encoding.

The Data Rate in this case refers to the 4-PAM symbol rate.

About Pulse Width Modulation (PWM)

In a NRZ (no-return to zero) signal, level-0 and level-1 represents the states of bit 0 and bit 1.
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In a PWM signal, each signal consists of two sub-phases, a level-0 followed by a level-1.

The PWM bit duration is calculated as follows:

TPWM = TMINOR + TMAJOR

Specify the value of TMINOR, as a fraction of the UI.

The data rate of the PWM is defined as:

FPWM = 1/TPWM

While generating a PWM waveform, at least four Samples per Unit Interval (SPUI) are required.

When minimum SPUI = 4, SPUI = (x/T_Minor), where x is an integer.

For example:

If T_Minor = 0.25, then the value of SPUI = 4x, that is, 4, 8, 12...

If T_Minor = 0.33, then the value of SPUI = 3x, that is, 6, 9, 12…

Example. The following example shows how to calculate the values of TPWM, TMINOR, and TMAJOR.

If the data rate is set to 200 MHz and T_Minor is set to 0.25 UI then,

TPWM = 1/200 M = 5 ηsec

TMINOR = 0.25 * TPWM = 1.25 ηsec

TMAJOR = (1– 0.25) * TPWM = 0.75 * TPWM = 3.75 ηsec
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DPOJet Settings

You can do calibration in two ways: Automatic and Manual.

Automatic

Use the automatic method when SSC is not available in the signal.

Do the following to set up the DPOJet application on the connected oscilloscope:

1. In the SerialXpress application, set the Base Pattern and Compile Settings parameters for calibration.

2. Select Calibration from the toolbar.

3. From the list of instruments, highlight an oscilloscope and click Connect.

4. In the Calibration Setup group, set the DPOJet Settings to Automatic. The following message is
displayed:

5. On the oscilloscope, click Default Setup and Autoset to check if the signal is available.

6. Select Analyze > Jitter & Eye Analysis > Wizard > One Touch Jitter.

DPOJet automatically configures various parameters for optimum performance.

7. In the SerialXpress application, click OK in the message box to proceed with calibration.
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Manual

Use the manual method to measure SSC.

Do the following to set up the DPOJet application on the connected oscilloscope:

1. In the SerialXpress application, set the Base Pattern and Compile Settings parameters for calibration.

2. Select Calibration from the toolbar.

3. From the list of instruments, highlight an oscilloscope and click Connect.

4. In the Calibration Setup group, set the DPOJet Settings toManual.

5. Set the path and file name to create the correction file and select Apply Calibration.

6. Click Calibrate. The following message is displayed:

7. On the oscilloscope, perform the following steps:

Click Default Setup and Autoset on the oscilloscope front panel.

Select Analyze > Jitter & Eye Analysis > Wizard > One Touch Jitter.

Set the required record length.

8. In the SerialXpress application, click OK in the message box to proceed with calibration. The
following message is displayed:

9. Configure all the DPOJet parameters manually.

10. In the SerialXpress application, click OK in the message box to proceed with calibration.

NOTE. During calibration, if a warning or an error message appears in the DPOJet application,
SerialXpress will not yield correct results.
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Noise

Full Bandwidth Gaussian Noise

SerialXpress supports white Gaussian distribution. Since the noise is generated in the digital domain, the
Gaussian distribution is spectrally flat and is half the sampling frequency. The amplitude of this noise can
be controlled. The noise generated is independent for each compilation.

Single Tone Noise

SerialXpress supports single tone noise generation. The frequency can be a maximum of half of the
sampling frequency.

Limitation of pattern length on randomness

The noise is created as part of the waveform data. Due to AWG memory limitations, the waveform data
has finite length. This limits randomness of the noise. The larger the waveform length, the greater is the
randomness of the noise. The AWG7000 supports waveforms up to 64 M samples and hence the noise
is random up to this limit. For waveforms greater than 64 M samples, the noise pattern repeats. The
AWG70000 supports waveforms up to 16 G samples; the noise is random up to this limit. For waveforms
greater than 16 G samples, the noise pattern repeats. This limitation of the AWG pattern length applies
to random jitter.

Impact of noise on a differential waveform

When noise is added to a differential waveform, its amplitude appears doubled. This is because the noise is
generated in the application and appears as a waveform output for AWG.
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Generate Common Mode Noise

The following features of SerialXpress are used to generate Common Mode Noise:

Note the Invert Bits selection in the Base Pattern tab.

Note the Noise and Single Tone selections in the Transmitter tab.

To generate Common Mode Noise, for example, 200 mV at 33 MHz, complete the following steps:

1. Select a desired Base Pattern

a. Clear the Invert Bits selection in the Base Pattern tab.

b. Set the Noise Amplitude to 200 mV and theSingle Tone frequency to 33 MHz.

c. Compile and send the waveform to Channel 1.

2. Use the same Base Pattern as described above.

a. Select Invert Bits in the Base Pattern tab.

b. Set the Noise Amplitude to 200 mV and theSingle Tone frequency to 33 MHz.

c. Compile and send the waveform to Channel 2.

The two channel outputs are combined coming out of the instruments as [(Ch1 + CH2)/2] to generate
Common Mode Noise.
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Generate Inter-Channel Skew

The following examples shows how to use the Delay feature in the Compile Settings tab to generate
Inter-Channel Skew.

1. Set the Delay to zero and compile the desired pattern.

2. Send the desired pattern to one of the output channels, such as Channel 1.

3. In the Compile Settings tab, change the Waveform Name.

4. Set the Delay to the desired channel skew.

5. Compile and send the waveform to Channel 2.

The Channel 1 and Channel 2 now have the specified Inter-Channel Skew.

Periodic Jitter - Sample Test Results

The maximum value of periodic jitter that can be set in the Transmitter tab for various combinations of
data rate and frequency is as follows:

Table 44: Periodic jtter maximum values

Data
Rate Frequency of Periodic Jitter

10
0 kHz

50
0 kHz

1 MHz 10 MHz 20 MHz 40 MHz 80 MHz 10
0 MHz

50
0 MHz

Periodic Jitter (Pk-Pk)

0.5 Gb/
s

50 UI 30 UI 18 UI 10 UI 6 UI 2 UI 1 UI 0.25 UI -

1 Gb/s 50 UI 35 UI 25 UI 15 UI 10 UI 6 UI 2 UI 1 UI -

2 Gb/s 50 UI 40 UI 35 UI 20 UI 15 UI 10 UI 4 UI 1 UI 1 UI

3 Gb/s 50 UI 50 UI 40 UI 30 UI 20 UI 12 UI 6 UI 2 UI 1 UI

4 Gb/s 50 UI 50 UI 50 UI 40 UI 30 UI 15 UI 8 UI 2 UI 1 UI

5 Gb/s 50 UI 50 UI 50 UI 45 UI 35 UI 16 UI 8 UI 4 UI 1 UI

6 Gb/s 50 UI 50 UI 50 UI 50 UI 40 UI 20 UI 12 UI 4 UI 1 UI

xxx
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Main Menu Default States

Table 45: Default states and selection

Item Options Default state

Menu Bar

Restore Default Setup Always enabled

Open Setup… Always enabled

Save Setup Always enabled

Save Setup As… Always enabled

Import from File… Always enabled

Import from Tektronix Oscilloscope… Always enabled

Save Data As… Enabled when a waveform is available
in the Waveform List.

File

Exit Always enabled

Standard Toolbar Always enabledView

Status Bar Always enabled

Select Mode SingleConfigure

Find Instruments… Always enabled

Compile Always enabled except when the
compilation is in progress.

Compile Settings Always enabled

Waveform

Graph Setup Always enabled

Presets SATA, USB 3.0, HDMI, DisplayPort —

Run Enabled when SerialXpress is running
in the online mode.

Stop Enabled when SerialXpress is running
in the online mode.

All Outputs On/Off Enabled when SerialXpress is running
in the online mode.

Calibration Always enabled

System

Option Installation Always enabled

Waveform List Always enabled

Graph Always enabled

Instrument Control Always enabled

Overview Always enabled

Window

Close All Always enabled

Help Topics Always enabled

Technical Support Always enabled

Help

About SerialXpress Always enabled

Toolbar
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Table 45: Default states and selection (cont.)

Item Options Default state

Mode Single, Sequence Single

Calibration - Always enabled

Overview - Always enabled

Find instruments - Always enabled

Graph Setup - Always enabled

Compile - Always enabled except when
compilation is in progress.

Compile Settings - Always enabled

On/Off - Enabled when SerialXpress is running
in the online mode.

Run - Enabled when SerialXpress is running
in the online mode.

xxx

110 SerialXpress User Manual



Reference Default Values

Default Values
Table 46: Default values and selection

Item Option Range/selection Default value/selection

Base Pattern tab

Standard SATA, SAS, Display
Port, PCI-Express, Fiber
Channel, General, USB,
MIPI

General

Pattern Selections are different for
different patterns

Clock

From File - Disabled

Base Pattern

User Pattern - Disabled

Scrambling Enabled, Disabled Disabled

Polynomial - X15+X5+X4+X3+1

Scrambling

Register Initial Value - 1111111111111111

PWM - Enabled, Disabled Disabled

T_Minor - 0 UI to 0.5 UI 0.33 UI

Scheme NONE (NRZ), NRZI,
4-PAM

NONE (NRZ)

8B10B Enabled, Disabled Disabled

Encoding

Disparity RD+, RD– RD+

Data Rate 500 Kbps to 25 Gbps
(AWG70002A)

500 Kbps to 50 Gbps
(AWG70001A)

500 Kbps to 6 Gbps
(AWG7000B and
AWG7000C without
interleave)

500 Kbps to 12.0 Gbps
(AWG7000B and
AWG7000C with
interleave)

500 Kb/s to 3300 Mbps
(AWG5000)

500 Kbps to 12 Gbps
(Offline)

1 GbpsSignal

Idle State 53 ns to 100 μs 320 ns

Offset Idle State Offset –0.5 V to +0.5 V 0 V
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Table 46: Default values and selection (cont.)

Item Option Range/selection Default value/selection

Maximum +0.5 V to –0.25 V +0.5 V (Offline)

Depends on the maximum
amplitude value of the
AWG (Online)

Amplitude

Minimum +0.25 V to –0.5 V –0.5 V (Offline)

Depends on the maximum
amplitude value of the
AWG (Online)

Rise/Fall Time 10/90 or 20/80 20/80

DCD 0 UI to 1 UI 0 UI

Rise 0.6/sampling rate to
0.6/data rate

100 ps

Rise/Fall

Fall 0.6/sampling rate to
0.6/data rate

100 ps

Base Pattern Enabled, Disabled Enabled

Clock Data rate, Data rate/2,
Data rate/4, Data rate/8,
User-defined

Data rate/2

Marker Settings

High/Low All High, All Low, Trigger All High

Transmitter tab

Magnitude 0 UI to 50 UI 0 UI

Frequency 10 kHz to Data rate/2 10 MHz

Periodic Jitter

Phase 0 ° to 360 ° 0 °

Random Seed 1 to 99999 12345

Rj1 Crest Factor (Peak) 1 to 20 12.732

Magnitude 0 UI to 0.5 UI 0 UI

Frequeny-Low (Hz) 1 Hz to (Frequency-High –
1 M)

100 kHz

Random Jitter

Frequency-High (Hz) 1.1 MHz to Data rate/2 Date rate/2

Shape Sine, Triangle, Custom Triangle

Spread Up, Down, Center, Unequal Down

Unequal Spread 0% to 100% 0%

Minimum Duration 0 μs to 5 μs 0 μs

Location 20% to 80% 50%

df/dt 0 ppm/μ to 5000 ppm/μs 0 ppm/μs

Frequency Deviation 0 ppm to 200000 ppm 4000 ppm

SSC

Frequency Modulation 10 kHz to 500 kHz 33 kHz

Noise - 0 Volt (RMS) to 0.5 Volt
(RMS)

0 Volt (RMS)

Pre/De-emphasis - 0 dB to 20 dB 0 dB
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Table 46: Default values and selection (cont.)

Item Option Range/selection Default value/selection

Advanced Setup - Enabled, Disabled Disabled

Add Noise At - Near end, far end Near end

Channel/Cable tab

ISI - 0 UI to 1 UI 0 UI

Select the Mode Non-Cascading,
Cascading

Non-Cascading

Bandwidth limit –
embed/de-embed

None, Auto, Custom None

Read from File - s4p

Write to File - -

Sampling Frequency 25 GHz, 50 GHz 25 GHz

S-Parameter Filter

ISI Scaling 0 to 10 1

xxx
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Index

Symbols and Numbers
4-PAM, 39
8B10B, 39

A
Advanced settings

AWG, 70
Advanced setup, 60
Advanced Setup, 35
Aggressor signal, 63
Amplitude

maximum, 46
minimum, 46

Application
basic operations, 7
exiting, 11
installation, 4
ordering, 3
overview, 9
starting, 11
system requirements, 3

Arbitrary waveform generator
(AWG)
specifications, 92

Automatic, 26
AWG5000

control, 70
AWG5000 and AWG7000 setup

Base data signal generation, 6
AWG7000

control, 70
AWG70000

control, 69
AWG70000 Series configuration

utility, 4
AWG70000A setup

Base data signal generation, 5

B
Bandwidth expansion filter, 27
Bandwidth limit, 61
Base data

calibration, 51

creating calibration data, 53
creation, 48
settings, 39

Base pattern tab, 39

C
Calibration, 20
Calibration setup, 21
Channel/Cable tab

settings, 61
Common Mode Noise, 107
Compile button preferences, 26
Configuration utility

AWG70000 Series, 4
Connecting to an instrument, 67
Conventions, 2

D
Data rate, 45

default values for various
standards, 45

DCD, 47
Default values, 111
Delay, 26
Delete

waveform, 19
df/dt, 59

Location, 59
Minimum duration, 59

Differential, 63
Directories, 12
Disparity, 44
DPOJet Settings, 104

Automatic, 104
Manual, 105

Duty cycle distortion, 95

E
Encoding scheme, 44
Error messages, 87
Eye DPO, 84

F
Fall time, 47
Far end, 60
Feedback, 2
File format

10-bit data, 50
8-bit data, 49
Symbol data, 50

File name extensions, 12
Find instruments, 67
Free trial, 1
Frequency

Deviation, 59
Modulation, 59

G
Graphs

types, 24
zooming, 77

I
Idle state, 45

Offset, 46
waveforms, 45

Import from Tektronix
oscilloscope, 19

Importing data from a file, 32
Instrument control, 67
Instrument setup, 20
Instruments

control, 73
control (AWG5000), 70
control (AWG7000), 70
control (AWG70000), 69

Inter symbol interference (ISI), 61
Inter-Channel Skew, 108
Interleave, 92
Inverse filter, 62
ISI scaling, 62
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J
Jitter parameters

settings, 57
Jitter summary, 84

M
Main menu default states, 109
Marker settings, 47
Menu bar, 14

Configure, 15
File, 14
Help, 17
System, 16
View, 15
Waveform, 15
Window, 17

Mode
Sequence, 20
Single, 20

N
Near end, 60
Noise, 95

Generating Common Mode
Noise, 107

Noise Frequency, 60
Normal eye, 83
NRZ, 39
NRZI, 39

O
Open setup, 32
Option

software, 3
Option installation

license key, 31
Oscilloscope

connect and control, 73

P
Parameters

definition, 95
Periodic jitter, 81
Polynomial

scrambling, 43

PRBS editor, 34
starting values, 91

Pre/De-emphasis, 60
Pre/De-Emphasis, 100
Pre/De-Emphasis and Preshoot

Advanced Setup, 35
Preshoot, 60
Pulse Amplitude Modulation

(PAM), 102
Pulse Width Modulation

(PWM), 102
PWM, 43

R
Random jitter, 95
Read from file, 62
Register initial value, 43
Related documentation, 2
Rename

waveform, 19
Repeat, 27

Automatic, 27
Manual, 27

Restore default setup, 32
Rise time, 95
Rise/Fall, 47

S
S-Parameter, 61

Cascading, 62
Filter mode, 62
four-port, 63
one-port, 63
Touchstone files, 63
two-port, 63

Save data as, 19
Save setup, 32
Save setup as, 32
Scrambling, 43
Select the mode, 61
Send to AWG, 19
Sequence, 54
Shape, 58
Shortcut keys, 91
Show graph, 19
Signal

Patterns, 39

Standards, 39
Simulated data signal, 79
Sine 1, 30
Single, 54
Single-ended, 63
Spread, 58
Spread spectrum clocking

(SSC), 96
Custom, 96

SPUI, 36
Status bar, 18

T
T_Minor, 43
Tap Co-efficients, 37
TekVISA, 67
TIE, 85
Toolbar, 17

Batch setup, 28
Calibration, 20
Compile, 25
Compile settings, 25
Find Instruments, 23
Graph setup, 23
On/Off, 28
Overview, 22
Run, 28

Total jitter, 82
Transmitter tab, 57

U
Unequal spread, 59
User pattern, 42

Binary, 42
Hex, 42
Symbol, 42

W
Waveform list, 18
Wrap between sequence

elements, 97

Z
Zeroing, 94
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